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IntroductIon
 
Welcome to the Fundamentals of Design Drafting.  The content presented in the Fundamentals of Design Drafting text is written to 
assist students in learning and developing a core knowledge of design/drafting and skill-building procedures.  It provides an industry 
perspective of the basic concepts and principles that are used in the design and drafting industry.  The content in the text is intended to 
help students begin preparing for the American Design Drafting Association (ADDA) industry recognized certification exams.   

A student’s success in this course is directly related to his or her ability to understand how to proceed in traditional and non-traditional 
class settings.  It is imperative for students to:

1. Read all material carefully.  Reread the material several times for total understanding. DO NOT SKIM.

2.  Understand the concept of an activity before you start the process of typing commands on the keyboard.

3.  The information you will type is presented in numbered sequence.  Follow the steps carefully,  
watching the screen as you proceed.

4. Read the concepts again if you are having difficulty understanding a particular item.

5. Repeat the steps of an exercise over and over to develop mastery.  Mastery means you are able to complete  
an exercise without looking at the book, and understand why you performed that particular function.

6. Ask questions if you do not understand or if you are having difficulty with the key strokes.

 

The Fundamentals of Design Drafting resources are flexible and instructors should feel comfortable supplementing  
curriculum resources that they have found successful throughout the years.

We welcome your suggestions, and hope that you will become part of the collaborative effort in educating our  
future engineers and architects. 
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Chapter 1

Basic drafting equipment
 
Throughout time, technical drawers use various methods and 
tools to draw and communicate their designs. Drawings can  
be made using a wide variety of media and plotting tools.   
The following chapter you will learn of some of the basic  
tools used that have helped drafters historically and today  
communicate their ideas.

media/reproduction
 
Throughout time, vellum was used to communicate important 
information such as documents and manuscripts because of its 
high quality and durable life.  Vellum is a thin translucent mate-
rial traditionally made from animal skins. Today, most vellum is 
made from cotton and is known as paper vellum.  It is commonly 
used where tracing is needed and can be purchased at art or draft-
ing supply stores.  Drawings using vellum are produced in low 
quantity due to its high cost. 

An English deed hand-written on fine vellum with 
large pine resin seal - dated 1638

Drafters also use polyester film for its durable properties.  This 
includes high strength, dimensional stability, clarity, tear resis-
tance, and moisture resistance.  The film can be easily machined, 
and its surface is treatable.  Many refer to this material as Mylar.  
Mylar is the DuPont trademark for polyethylene terephtalate 
(polyester) film.  Polyester film is used in many types of packag-
ing applications ranging from food and drugs to industrial and 
consumer goods.  Engineers and architects create plans and draw-

ings to be plotted onto sheets of polyester film. The plotted sheets 
then become legal documents from which copies or blueprints 
are made.  These sheets are more durable and can withstand more 
handling than typical bond paper..

A drafter completed drawing represents a tremendous amount 
of time. This is why the reproduction process is important to 
understand.  There are various ways to reproduce drawings in-
cluding blueprinting, diazo, microfilm, photocopying, etc.  Each 
has its pros and cons. For example, in blueprinting the original 
must be transparent. Blueprinting is one of the older reproduction 
processes and is frequently used today because of its low cost.  
Blueprinting uses various chemicals that produce white lines on 
a blue background. The blueprinting method allows an unlimited 
number of prints to be made without quality degradation.  This 
ensures highly accurate dimension information on all copies. 
The process that a blueprint goes though provides durability to 
prevent fading, marking, and alteration.  

Architectural Blueprint

The common blueprint in some cases was replaced by lower cost 
alternatives.  One of these alternatives was diazo prints or white-
prints.  Diazo paper is a combination of two chemicals coated 
on paper to create blue lines with a white background. These 
prints are also called bluelines.  Another alternative is photocopy 
printing.  Photocopying print technology is basically the copy 
machine technology using toner on bond paper.  The term “blue-
print” has continued to be used informally to refer to any of the 
methods of media reproduction. 
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 Drafting firms today invest in the technology of large format 
plotters and scanners.  Technology has taken a great hold in draw-
ing storage, retrieval and production.  Drawings that are created 
with computer aided drafting can be digitally stored on a comput-
ers hard drive or some other storage device.  Pencil, blueprints, 
and other drawings can be scanned, stored, and printed using 
scanners and large format printers.  These large format printers 
use ink and toner cartridges to print or plot the drawings.  Toner 
is a powder used in laser printers and photocopiers.  The toner 
forms text or images by melting toner particles onto paper, which 
allows them to fuse together.  Cost of toner and ink vary depend-
ing on the toner cartridge size and the quality of the ink.  Logi-
cally the more toner or ink needed, the higher the production cost 
of the print.

hp designjet 820 mfp

The technology found in today’s scanners and large format 
printers have helped drafters become more proficient in com-
municating and storing their drawings.  Printers and plotters 
provide drafters reproduction speed, accuracy, and repeatability.  
As technology continues to evolve and become more affordable, 
drafters will continue to take advantage of innovative reproduc-
tion methods.

1. Operator panel with touch LCD display
2. Integrated copy and scan
3. Guides for engineering and architectural standards
4. Print Engine - 100% toner efficiency
5. Technical LCD - Provides technical information for system status
6. Media Capacity - One or two rolls, field upgradeable
7. Image Processing System - ensures high quality and fast processing
8. Integrated Stacking - front or rear output stacking for up to 200 prints
9. Small Footprint - fully integrated, space saving device

drafting tools

Drafters use a number of drafting tools that assist them in  
drawing their designs.  This section will provide a brief  
overview of some of the well known board drafting tools  
that are being used today.  

drafting Board  

From artists to technical drawers, drafting boards provide an area 
and surface for these professional to draw.  Drafting boards come 
in many sizes and can be customized to fit the need or desire of 
the drafter.  In general, a drafting table has a large rectangular 
surface that can accommodate the size of the paper being used.  
The table typically has a plastic covering which must be very 
smooth to avoid any imperfections during drawing.  Drafting 
tables require a smooth straight edge for a T square or other  
rulers to be utilized.  Although computer aided drafting has 
become popular, many graphic designers, artists, and architects 
still rely on paper and pencil/pen graphics that require the use of 
a drafting table.

Kip 3000
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Typical Drafting Table

t square
 
A T square tool is shaped like a letter T and has two parts, the 
head and the blade.  The head is in a 90 degree alignment with 
the blade. When used with the drafting table, the 90 degree align-
ment allows drafters to draw horizontal parallel lines across their 
sheet.  The T square is used in connection with other drafting 
tools (triangles, protractors, curves, etc) to help guide and draw 
accurate angles and shapes.  An alternative to a T square, the 
straight edged or parallel rulers that are attached to the drafting 
board which slide up and down provide the same purpose as the 
T square.

Basic T Square

triangles

This tool is triangle shaped and comes in both 45/45 and 30/60 
degree angle patterns.  With the T square, triangles are used to 
draw lines at 15, 30, 45, 60 75, and 90 degree angles.  

45 Degree Triangle

protractors 
 
A protractor can be a half or full circle that is divided into  
degrees.  The protractor is used to measure angles from  
0 to 360 degrees.      

Compass
 
The compass tool is used to draw circles and arcs.  The compass 
is comprised of two legs, one with a point, the other with lead/ink 
and the two are connected by some type of adjustable hinge.   The 
compass point is set at the center mark of the desired circle or 
arc and the lead is then pivoted around that point.  A divider tool 
looks similar to the compass, but the divider has two points and 
no lead/ink.  The purpose of the divider is to measure the distance 
from one point to another.  
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Protractor & Compass

Caliper
 
A caliper is a device used to measure the distance between two 
opposing sides and can be adjusted to fit across the points to be 
measured.  A caliper is frequently used to measure the dimensions 
of smaller objects.  Calipers can accurately dimension internal 
and external components within 0.001 cm.

Digital Caliper

Curves
 
A curve is a thin plastic or metal tool that has a variety of curve 
shaped edges.  The curve tool is used for irregular curves that 
can’t be drawn free hand or with a compass.  The most common 
curve is the French curve. There are templates other than the 
curve that drafters can use to produce various shapes.

French Curves

lettering guide 
 
It is sometimes said that a good drawing can be ruined with 
bad lettering.  A lettering guide is a tool that is used to properly 
space lines for lettering.  Standards are set forth by the American 
National Standards Institute to provide guidelines for drafters to 
correctly letter. These standards lay a foundation for drafters to 
communicate details in their drawing.  The lettering guide helps 
drafters’ accuracy and efficiency comply with these lettering 
standards set forth.

pencils & pens 
 
A drafting pencil is an important tool of the traditional drafter. 
Not any old pencil will do; drafting pencils are high quality and 
very sharp to draw precisely drawn lines.  Drafting pencils come 
in a variety of pencil lead grades.  

The grade of hardness of pencil lead is indicated on the pencil 
by a number-letter code.  Leads range in hardness form very soft 
(7B) to very hard (9H). Soft lead pencils produce a dark line yet 
can be smudged easily; hard lead pencils do just the opposite.   
The grade of pencil lead required depends on the function to be 
performed.  For example, if an architect is lettering or drawing 
construction lines where accuracy is important, a hard pencil such 
as 4H, 5H, or 6H lead is required.  Softer, 4-6B pencils are used 
for larger quick sketches or figure studies. 
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Drafting pencils are manufactured as wooden pencils, lead hold-
ers, and mechanical pencils. Wooden pencils are created with 
wood and loaded with one of the various grades of lead.  Lead 
holders allow the drafter to swap lead grades as needed and have 
any amount of lead exposed and sharpened to any size.  

Pencil Grades

A mechanical drafting pencil is built to hold only one size of lead.  
Mechanical drafting pencils can support lead in diameter sizes of 
0.3mm to 0.9mm and can come in the numerous lead grades.

When drawings are to be made with ink, drafters use technical 
pens. Civil drafters, for example, In fact some drafting fields such 
as civil require that the drawing is made of ink.  One of the im-
portant reasons for using technical pens is because they reproduce 
well and can be filed on film.  Technical pens also offer sharp 
lines without the hazard of lead smudges.  An important reason 
for using technical pens is because they reproduce well and can 
be filed on film.  Technical pens vary in line width to provide dif-
ferent line sizes and sharpness.

Technical drawing ink must be of high quality and be fast drying 
to ensure reduced smearing and efficient work flow.  Ink should 
be semi flat black in color to avoid light reflection, and must not 
crack, chip, or peel from the drawing.  Drafters must also deter-
mine if the ink should be waterproof or erasable for corrections.

erasers & shields
 
The use of erasers is important to drafters as they edit, erase, and 
remove unwanted lines or letters.  Erasers come in all shapes and 
sizes but there are a few which are most widely used.  The most 
commonly used pink eraser is found on the typical wood pencil.   
The pink eraser is good for general erasing purposes, but often 
smears and can damage the paper if pressed to hard.  Plastic eras-
ers are another type, and they are the most often used in technical 
drawing for plastic lead or ink on polyester film.  Plastic erasers 
are usually white in color and come in block or pencil shapes. 

Drafters also use other tools to assist in the erasing or removing 
of discarded marks or lines. One of these tools is called an eras-
ing shield.  An erasing shield does exactly what its name implies; 
it protects the rest of the drawing from being erased.  Shields 
are usually thin sheets of plastic or metal that has holes or other 
shapes to guide the eraser.  

Eraser & Shield

The shield is laid flat on the drawing with a specific hole or 
shape over the desired area to be removed, and then the eraser 
is applied. Another tool used is a dusting brush to easily remove 
left over eraser particles to reduce the possibility of smearing 
or smudges.  For ink, drafters use different types of eradicating 
fluids to remove unwanted ink and film from the various  
drawing media.  
 
 



7

fundamentals of draftting

Chapter 2

Basic measurement systems
 
A unit of measurement sets forth a standard to quantify a given 
physical property.  For this purpose drafters must adhere to 
measurement standards to be able to communicate there ideas 
and drawings for others to comprehend.  Common Systems of 
Measurement include the following:

• Length 
• Area 
• Volume 
• Angle 
• Mass/Weight 
•  Power 
• Force 
• Acceleration 
• Temperature

Drafters use various scales to stay within the standards as set for 
in two different measurement systems English/Imperial System 
or Metric System.  In the United States the English/Imperial sys-
tem or U.S. customary units refers to the measurement standards 
used primarily in the U.S.  The metric system is also known as 
the International System of Units, is published by the Interna-
tional Standard Organization (ISO), which is the measurement 
system that the majority of countries have adopted.  

There have been efforts to move to the metric system but these 
customary units of measurement have a strong hold due to the 
size and growth of the U.S. in industry and the high financial 
costs to convert the existing infrastructure to metric. U.S. compa-
nies who do international business are more likely to use the met-
ric system due to international standards.  Because of this metric 
system is preferred in certain fields such as science, medicine and 
technology.  It is critical for drafters to have an understanding of 
these two measurement systems due to their wide use. 

scales and scaling
 
Utilizing a scale is an important part of being a drafter and mak-
ing the appropriate use of measurements.  Scales help a drafter 
draw a drawing “to scale”, which means that they can accurately 
portray a physical object, on paper or on screen, by enlarging or 
diminishing the scale of the object. Architectural and civil draw-
ings are usually scaled much smaller, but some small mechanical 
drawings must be scaled larger to be illustrated on a standard 
paper or in a CAD drawing for precise measurements.  The size 
of the scale used also depends on the amount of detail or the 
amount of information that a drafter needs to correctly describe 
the design.  

Typical Scales Used by Drafters

Scales can either be open divided or fully divided.  Open divided 
scales do not include the subdivided scale marks only the main 
units, such as inch and half inch.  Fully divided scales are marked 
or subdivided to include the smaller units like one sixteenth 
(1/16”).   

Depending on what is being drawn and why it is being designed, 
drafters utilize a number of different types of scales. Scales come 
in various shapes and sizes, the most commonly used scale is the 
triangular scale.  Scales are based upon one of two measurement 
systems the U.S. customary system or the metric (ISO) measuring 
system.  Scales that use the U.S. customary system use the inch 
as standard unit of measurement.  Scales using the metric (ISO) 
system use the millimeter as the standard unit of measurement.  
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inch scales
 
Typical inch scales are divided into feet, inches, and fractions of 
an inch.   A foot is divided into 12 inches and an inch is divided 
into 16 equal parts or fractions of an inch.  The inch scale is 
used to measure feet, inches and fractions of an inch.  The types 
of scales that use the U.S. customary system include architects 
scale, mechanical engineers scale, and civil engineers scale. 

 architects scale 
 
The architect scale is used to develop or read blueprints and 
designs for buildings and structural plans.  On a triangular archi-
tect scale there are 11 different scales (3/32”, 1/8”, 3/16”, 1/4”, 
3/8”, 1/2”, 3/4”, 1”, 1 ½”, 3”, & 12”).   Each of these 11 scales is 
equated to one foot (1’-0”).  For example, when using the 1/4” = 
1’-0” scale, every 1/4th of an inch is equal to one foot. It is im-
portant to note that scale does not equal size.  Which means that a 
1/4” scale converted in ratio form is equal to 1:48 size. 
 

Architects Scales

It is important to look closely at the subdivisions labeled on the 
scale.  Each side of the architect scale represents two scales both 
with numbers that run incrementally from left to right and from 
right to left.  The number or fraction labeled at each end of the 
triangular scale tool indicates the scale those numbers represent.  

Civil engineering scale
 
The civil engineering scale is used to show the size and features 
of land in relation to buildings, roads, drainage and other civil 
infrastructure.  The civil engineering scale uses inches that are 
divided into decimal parts.  There can be 10, 20, 30, 40, 50, and 
60 decimal parts per each inch. These decimal parts can represent 
any measurement such as an inch, a foot, a yard, or even a mile. 
Civil engineer’s scales have numbers that run incrementally from 
left to right. The whole number to the left of the number line 
indicates the scale those numbers represent.

Civil Engineers Scales

mechanical engineering scale 
The mechanical engineer’s scale is used mainly in the manufac-
turing sector doing mechanical drawings that use fractions and 
decimal inches.  On the mechanical scale an inch can be divided 
into 16th’s, 10th’s, or 50th’s.  When each inch is divided into 
16th’s the scale is similar to the architect’s scale; however, when 
it is divided into 10’s or 50’s units per inch it is much like the civ-
il engineer’s scale.   Using the 50 units per inch in a scale brings 
a high level of accuracy, which is needed for small mechanical 
or electrical parts.  Mechanical engineer’s scales also have scales 
that run incrementally both from left to right and from right to 
left. Mechanical engineering scales subdivisions include 1/32”, 
1/16”, 1/8”, 1/4”, 3/8”, 3/4”, 1/2”, and 1” units.
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Mechanical Engineer’s Scales

Frequently used language for mechanical drafters for scaling 
include:

Full scale  1” to 1” or  1:1
Half scale  ½” to 1” or 1:2
Quarter scale ¼” to 1”  or 1:4
Twice (double) scale 2” to 1” or  2:1

metric scale
 
The metric scale or the international standard (ISO) used on In-
ternational System of Units (ISO).  The metric scale is in decimal 
form and based upon the meter.  On the metric scale the units are 
based upon multiples of ten and there are no fractions.  The pri-
mary unit of measure used in this system is the millimeter (mm).  
The metric units of linear measurement are identified below. 

(ISO) Metric Symbols and Conversions

Millimeter (mm) 10 millimeters  = 1 centimeter  
Centimeter (cm) 10 centimeters = 1 decimeter   
Decimeter (dc) 10 decimeters = 1 meter          
Meter (m) 10 meters = 1 decameter   
Decameter (dam) 10 decameter = 1 hectometer 
Hectometer (hm) 10 hectometer = 1 kilometer    
Kilometer (km) 1 kilometer = 1000 meters
(Most commonly used are highlighted)

  

On the common triangle metric scale the following scales are 
paired together: 1:1 / 1:10, 1:2 / 1:20, 1:5 / 1:50, 1:100 / 1:200, 
1:500 / 1:1000, 1:1250 / 1:2500.  It is also important to be careful 
when measuring with the metric scale because different scales are 
paired on the same line but begin on opposite sides. A drawing 
that uses the metric scale and that is scaled using a ratio of 1:10, 
simply means that the real object is 10 times larger than the dia-
gramed object. If the scale is 10:1 then the real object is 10 times 
smaller than the diagramed object.

 

Metric Scales
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Comparing Units of Length

Unit U.S. ISO Equal
1 inch (in)   25.4 mm
1 foot (ft) 12 in 0.3048 m
1 yard (yd) 3 ft 0.9144 m
1 mile (mi) 5,280 ft 1.609344 km

Basic measurement Quantities 
 
Drafters must be well versed in all fundamental measurement 
systems that require mathematical applications.  Today, most 
drafters use computer programs that computer the mathematical 
applications measures.  However, each drafter must have a fun-
damental understanding of the mathematics and measurements 
behind the computer program.  Located below are some of the 
various measurement systems that must be understood and a few 
basic examples of how an engineer or architectural drafter applies 
these systems. 

mass/Weight 
 
Mass is the amount of matter an object has, and weight is the 
force generated by the gravitational attraction of the earth.  These 
two terms differ, however in general use today, weight and mass 
are equivalent.  The U.S. commonly uses the ounce, pound, and 
ton; the hundredweight is also used in agriculture and shipping 
purposes..

units of mass

Unit U.S. ISO  (equal)
1 ounce (oz)  28.349523125 g
1 pound (lb) 16 oz 453.59237 g
1 hundredweight (cwt)    100 lbs 45.359237 kg
1 (short) ton 2000 lbs 907.184 74 kg

Volume
 
Identifying volume of a solid object is trying quantify how much 
space it occupies.  An object must have some sort of three-dimen-
sional space to hold volume. Units of volume can be measured in 
liquid and dry material.  The generally used U.S. units of volume 
as well as liquid and solid units can be viewed below.

Volume in general

unit divisions iso equal
1 cubic inch (cu in)   16.387064 mL
1 cubic foot (cu ft) 1728 cu in 28.316846592 L
1 cubic yard (cu yd) 27 cu ft 764.55485798 L

liquid volume

unit u.s. iso equal
1 fluid ounce (fl oz)  29.57353 mL 
1 cup (cp) or (c) 8 fl oz 236.5882 mL
1 (liquid) pint (pt) 32  fl oz 473.1765 mL
1 (liquid) quart (qt) 2 pt / 32 fl oz  946.3529 mL
1 gallon (gal) 4 qt /128 fl oz     3.785412 L
1 oil barrel (bbl) 42 gal 158.9873 L

dry volume

unit divisions    iso equal
1 (dry) pint (pt) 33.60031 cu in    550.610 5 mL
1 (dry) quart (qt) 2 pt  1.101221 L
1 (dry) gallon 4 qt 4.404884 L
1 bushel (bu) 4 pk 35.23907 L
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degrees/radians  
 
Mass is the amount of matter an object has, and weight is the 
force generated by the gravitational attraction of the earth.  These 
two terms differ, however in general use today, weight and mass 
are equivalent.  The U.S. commonly uses the ounce, pound, and 
ton; the hundredweight is also used in agriculture and shipping 
purposes.

An angle measuring 1 radian subtends an arc equal in length to 
the radius of the circle.

area 
 
Area is a measurement of the space surrounded by an enclosed 
region.  U.S. units of area are measured by squaring the inch, 
foot, yard, and the mile.  Architectural drafters use the unit of 
square feet to describe the area specifications of a room in a 
building or a home.   Civil drafters use the acre unit to communi-
cate land or property size. 

units of area

unit u.s. iso  (metric)
1 sq inch  645.16 mm²
1 sq foot 144 sq in 0.09290304 m²
1 sq yard  9 sq ft 0.83612736 m²
1 sq mile             3,097,600 sq yd   2.58998811033km²

perimeter 
 
The perimeter is the measurement around a given two-dimen-
sional space.  Perimeter is used when calculating the border of an 
object such as a yard or flowerbed when a fence or other border 
will be installed around the edges.  Calculating the perimeter of 
an object is different than the area because area takes into con-
sideration all of the surface area within the perimeter, not just the 
surrounding border of the object. Circumference is the perimeter 
term used when calculating the distance around a closed curve 
such as a circle.

Common perimeter (p) formulas

shape formula 
           
Square  P = a + b + c + d   
(Condition:  a, b, c, d indicate the length of each side)

Triangle P = a + b + c          
( Condition:  a, b, c indicate the length of eachside)

Circle  P = 2 • π • r 
(Condition:r stands for the radius and π = 3.14159265)

Equilateral Polygons   P = na 
(Condition:  n represents the number of sides; a indicates the 
length of each side)
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mathematical review 
 
Having a good understand of general mathematical applications 
is critical for a successful drafter.  Drafters must work with frac-
tions, decimals, percentages, and use the fundamental math for-
mulas mentioned above.  Engineers and architects will be trained 
in advanced mathematical problem solving to understand the 
math behind computer software programs that design their work.  
The purpose of this text is to review the basic math applications 
that all drafters should recognize.   

fractions 
 
There are two components to a fraction, a numerator (top part of 
the fraction) and the denominator (bottom part of the fraction).

Fractions must be reduced to the lowest terms.  To do this, divide 
the numerator and denominator by their greatest common factor 
or any common factor.  Keep dividing until there are no more 
common factors.

Example:   4/8 = 2/4 = 1/2 

•  adding & subtracting fractions 
Denominators must be the same to add and  
subtract fractions.

 Example:   3/8 + 1/8 = 4/8 = 1/2 
 (remember to reduce to the lowest terms)

 Example:   3/8 – 1/8 = 2/8 = 1/4
 
 If the fractions have different denominators:
 First find the least common denominator for both fractions. 

Write the equivalent fractions using the new denominator.  
Then add or subtract the fraction, and reduce if necessary. 

 1/3 + 3/5 = ? 
 The least common denominator is 15. 
 1/3 + 3/5 = 5/15 + 9/15 = 14/15

•  Multiplying Fractions
 Denominators do not have to be the same.  Simply multiply 

the numerators together and then multiply the denominators 
together.

 Example:   1/3 x 3/4 = 3/12 = 1/4 (again, remember to  
reduce to the lowest terms)

•  Dividing Fractions
 First, invert the second fraction upside down,  

and then multiply.

 Example:   3/4 ÷ 2/3 = (3/4 x 3/2) = 9/8 or 1 1/8

•  Working with Compound Fractions
 To add, subtract, multiply, or divide compound fractions, the 

numbers must first be converted to improper fractions.  To 
do this, the whole number must be multiplied by the denomi-
nator of the fraction and then added to the numerator while 
keeping the same denominator.

 Converting a compound fraction to an improper fraction:   
5 3/4 = [(5 x 4 +3) / 4] = 23/4 

 Example: 2 1/2 x 3 1/3 = 5/2 x 10/3 = 50/6 or 8 1/3

decimals
 
•  Converting Common Fractions into Decimals
 Fractions can be written as decimals.  To convert a fraction 

to a decimal, divide the numerator by the denominator.

 Example: 12/7 is 12 divided by 7. 
 Using a calculator, 12 ÷ 7, equates to 1.714285.

•  Converting Decimals into Common Fractions
 Write the decimal and divide it by 1. Then multiply the 

nominator and denominator by a factor of 10 for a single 
digit after the decimal.  Add an additional zero for each ad-
ditional number so that there is a zero for each number after 
the decimal.  
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 Example: convert 0.8 to a common fraction    
 Divide decimal by 1:0.8/1    
 Multiply nominator and denominator by 10: 

  (.8 x 10) / (1 x 10) = 8/10
 Reduce fraction:   4/5
 
 Example: convert .375 to a common fraction
 Divide decimal by 1:0.375/1    
 Multiply nominator and denominator by 1000:  

(.375 x 1000) / (1 x 1000) = 375/1000
 Reduce fraction:   3/8

Decimal Values
 1.714285
Tenth 
Hundredth
Thousandth
Ten Thousandth
Hundred Thousandth
Millionth

percentages
 
Percentages are similar to fractions and decimals since all three 
methods provide different ways to communicate the same thing: 
describing numbers that have been divided into parts.  Percent-
ages are representations of parts per hundred.  This means that 
a percentage such as 50% really means that you are working 
with 50/100 or 1/2.  It is important to remember that percentages 
do not always represent parts smaller than one hundred.  For 
example, 200% is twice the number, or in scaling terms twice or 
double scale (2:1) of the object.

•  decimal to percentage

 To create a percentage from a decimal move the decimal 
point two places to the right.

 Examples: .10 = 10%;  .40 = 40%;  .0525 = 5.25%
 Reverse the process to create a decimal from a percentage.  

Move the decimal point two places to the left.

 Examples: 20% = .2;  62.5% = .625;  4.55% = .0455

•  solving percentage problems

 To calculate the percentage of a number, first convert the 
percentage to a decimal then multiply the numbers. 

 Example: Calculate 250% of 50:    
(250% = 2.5)   2.5 x 50 = 125

 Example: Calculate 12.5% of 200:   
 (12.5% = .125)   .125 x 200 = 25

 To determine the value that represents the percentage of a 
number, first convert the percentage to a decimal then divide 
the numbers. 

 Example: 15% of what number is 630?    
(15% = .15)    630/.15 = 4200 
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Chapter 3

hardware and software Components

One of the purposes of this text is to acquaint each student with 
the principles of drawing via a computer.  To accomplish this, 
each user must first learn the basics of how to effectively operate 
a microcomputer before attempting to learn the mechanics of any 
drafting software.

Components of a microcomputer system
A microcomputer or personal computer (PC) is an electronic 
device used as a tool to help you perform a certain task.  This tool 
is made up of several components (parts) that together become a 
microcomputer system.  The three components of a microcom-
puter system are the hardware, the software, and the user.

hardware
Hardware is the physical machinery component of a microcom-
puter system.  The hardware you will use for this course consists 
of three parts:

Input There are two input devices, the keyboard and the 
mouse.  The keyboard will be used to put information 
into the working part of the computer.  When you begin 
to draw, the mouse will serve as the major input device.

CPU The central processing unit (CPU) is the brain of the 
computer.  This is the place where the information  
you type is converted into a language the computer  
can understand.  The information is manipulated in  
the CPU according to your instructions.  This hardware 
unit also houses the primary storage area of the system.   
(A detailed discussion of storage will follow.)

Output The output component is the part of the system that is 
used to receive and display the information from the 
CPU.  Two forms of output will be used during this 
course: the monitor and the plotter.  The monitor is the 
screen that looks similar to a TV screen.  The plotter  
(the drafting term used for printer) may be used to print 
a “hardcopy” of the information received from the CPU.

software
Software is the set of instructions that tells the computer what to 
do.  Software is divided into two main categories:

 operating system (Windows).  An operating system 
contains a series of software programs (files) that: 1) 
supervise the operations of the Central Processing Unit. 
2) control the input, output and storage functions of the 
microcomputer system, and 3) support the use of appli-
cations programs.  Windows programs such as Windows 
95, Windows 98, Windows 2000, Windows XP, and 
Windows Vista have replaced the older DOS system.  
This book was written to correspond with Windows XP 
and illustrations are based on this system.

applications.  Application software can be divided 
into two parts:

 Program files.  The five basic types of software applica-
tions programs are: word processing, spreadsheet, data-
base, graphics and communications. You will be using 
A+CAD (a graphics program) to produce the required 
drawings for this course.  

 Data files.  Data files are the documents you produce as 
a result of using the program files.

 Windows.  WINDOWS is a program that enables your 
computer to perform in a graphic-oriented environment.  
This environment is similar to the way a Macintosh 
functions and is typically called WYSIWYG--what you 
see is what you get.  What you see on the window is 
what you will get on the printed copy. 

user
The third component of a computer is the user, the person who 
is going to operate the computer.  You are the most important 
component of the system.  The hardware and software cannot 
run themselves.  Nothing will happen unless a person inserts the 
disk containing the software program, turns on the computer, and 
instructs the computer to perform specific tasks.
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units of measure
Ounces, pints, quarts, and gallons are used as units of measure 
for containers of liquid.  Similarly, there are units of measure for 
the space consumed by the information used in a microcomputer 
system.  Operating files, program files, and data files all consume 
space.  Typically, the units of measure for computer systems are:

Bit A bit is the smallest unit of measure. Eight bits are used 
together in the form of electronic impulses to produce a 
simple letter or character (called a byte).

Byte One character space of information such as a letter, 
number, symbol, or space on the Spacebar.  A byte is 
made up of eight bits.

Kb A Kb (Kilobyte) is equal to 1024 bytes.  Most people 
working with computers round this figure to 1000 for 
ease of use.  K stands for “Kilo” which means 1000.

mb A Megabyte is equal to a million bytes of information.

gb A Gigabyte is equal to a billion bytes of information.

memory and storage

The containers that the computer system uses for holding infor-
mation are called storage areas. These storage areas are called 
primary and secondary storage.

 primary storage.  The primary storage area resides in 
the CPU and is called “memory.”  The memory in the 
CPU is divided into two parts:

 rom.  ROM stands for Read Only Memory. The 
program files that are stored in this part of the CPU are 
permanent files.  They cannot be altered or deleted by 
the user.  The files contained in ROM are similar to a 
human being’s central nervous system.  Your heart beats 
and you breathe even when you are asleep.  The pro-
gram files in ROM run as needed without the user telling 
the computer system to run them.

 ram.  RAM  stands for Random Access Memory.  The 
files that reside in this part of the CPU are there tempo-
rarily. This is the area of storage that contains the pro-
gram and data files that you use and create.  When the 
power is turned off, RAM is emptied.  When the power 
is turned on, the program files must be loaded back into 
RAM in order to be used.  Remember, this is temporary 
memory.  Think of RAM as being similar to a human 
being’s conscious memory.  When you are awake, you 
consciously carry out specific tasks; but when you fall 
asleep, those tasks are gone from your conscious  
memory.  The amount of RAM contained in a CPU  
varies from computer to computer.  The amount of RAM 
a computer requires is dependant upon the operating 
system and the applications (programs) that it will run  
Software manufactures usually publish “system require-
ments” for their software which should specify the oper-
ating system and hardware requirements needed for the 
application.  As programs become more sophisticated, 
they require more temporary memory.  

 secondary storage.  The secondary storage contain-
ers used by a microcomputer system are usually disk 
storage containers.  System files, program files, and data 
files that need to be used at another time or that should 
not be forgotten are stored on a disk.  This is similar to 
the process human beings use for writing on paper the 
things that should not be forgotten.  The information on 
paper can be put back into the conscious memory by 
reading, or new information can be added to the con-
scious memory by reading.

Three types of secondary disk storage are:

 Hard (fixed) disk.  Most microcomputers have the 
capability of containing a hard or fixed disk drive within 
the CPU.  A hard disk drive is not a part of the central 
processing unit, but it is often housed in that piece of 
hardware for safety and convenience purposes.   
Typically, a hard disk drive may contain two, three, or 
four hard disks.  These disks are made of metal and are 
stationary, thus the terms “hard” and “fixed.”  The user 
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does not insert a hard disk into a disk drive, because it is 
already in the drive. The controller instructs the com-
puter system to retrieve and/or save information to or 
from the hard disk. Hard disks have exploded in storage 
capacities in the past few years. Storage capacities have 
multiplied a hundred fold in less than ten years.  One 
hundred gigabyte drives are common as this is written.

 usB flash drives  USB flash drives are flash memory 
data storage devices integrated with a USB (universal 
serial bus) interface.  They are typically small, light-
weight, removable and rewritable. These are commonly 
referred to as a “ThumbDrive” or “JumpDrive”.  USB 
Flash drives offer advantages over other portable storage 
devices, particularly the floppy disk.  They are more 
compact, generally faster, hold more data, and are more 
reliable than floppy disks.  These types of drives use 
the USB mass storage standard, supported natively by 
modern operating systems such as Windows, Mac OS X, 
Linux, and Unix.

 Compact disc.  A Compact Disc or CD is and optical 
disc used to store digital data, originally developed for 
storing digital audio.  Compact Disc technology was 
later adapted for used as a data storage device, known as 
a CD-ROM, and to include record-once and re-writable 
media (CD-R and CD-RW respectively)

 
 
 digital Versatile disc. DVD (:Digital Versatile Disc” 

or “Digital Video Disc”) is an optical disc storage 
media format that can be used for data storage.  DVDs 
resemble Compact Discs in that they have the exact ap-
pearance and both are optical storage media so similar 
that a DVD reader or writer can usually read CDs, but 
DVDs are encoded in a different format of much greater 
density, allowing a data storage capacity 8 times greater. 

Keyboards and special Keys

The location of certain keys on a keyboard may vary depending 
upon the style and the make of the microcomputer being used.  It 
is important for you to become familiar with the keyboard on the 
microcomputer you are using before you start to type.

Cursor The cursor is a blinking rectangle that appears 
on the monitor screen to indicate the position 
where the next message will display or where 
the next key that is taped will display.

Function Keys These special, dark gray keys, numbered F1 
through F10, may be positioned at the left side 
of the main keyboard, or at the top.  The func-
tions they perform will change depending on 
the software program being used.

Booster Keys The Ctrl (control), Alt (alternate), and Shift 
keys are called booster keys because they boost 
other keys to perform a function they do not 
ordinarily perform.  A booster key does not 
perform any function until it is used in conjunc-
tion with another key.  You can hold the shift 
key down as long as you want to, but nothing is 
going to happen until you tap another key. The 
same is true for Ctrl and Alt.  When a booster 
key is required, hold the booster key down, 
then tap the other key that is required for the 
special function, and then release both keys. 

Enter or Return The Enter key is similar to a Return key on an 
electric typewriter.  It is used to advance the 
cursor to the beginning of the next line and/or 
to enter information into RAM.  This is usually 
a large key on the right side of the alphabet 
keys and may be marked with “Enter,” “Re-
turn,” or an arrow pointing down and to the 
left.
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Caps Lock The Caps Lock key is used to display all al-
phabet characters in capital letters (uppercase).  
Numbers, symbols, and punctuation marks are 
not affected by Caps Lock button.  Some key-
boards have a light indicating when the Caps 
Lock function is on.  Since this key is a toggle, 
tapping Caps Lock will turn the function off.

ESC The Esc (Escape) key is your friend.  It is 
used to back out of, or interrupt commands or 
functions you no longer wish to perform.  Its 
location will depend on the keyboard you are 
using.  It may be positioned at the upper left 
of the common keys or at the upper left on the 
numeric keypad.

Backspace The Backspace key is usually used to delete the 
character to the left of the cursor.  This key is 
located above the Enter key on the top row of num-
bers.  It may contain an arrow pointing to the left.

Del The Del (delete) key is used to delete the char-
acter on which the cursor is positioned.

Num Lock This key is a toggle that changes the action of the 
numeric keypad from cursor movement to num-
bers, and back again.  The keyboard you are using 
may have a light that indicates when the Num 
Lock function is activated, thus allowing you to 
use the numeric keypad for entering numbers but 
not for moving the cursor.  If you wish to deacti-
vate this function, tap the Num Lock key.

Cursor  These keys are marked with arrows pointing 
Movement up, down, left, and right.  The keys marked 
Keys Home, End, PgUp, and PgDn may also be used 

to move the cursor.  You may have two sets of 
these keys on the keyboard you are using.  You 
may use either set.  Keep in mind that the Num 
Lock function must be deactivated for you to 
use the cursor movement keys on the numeric 
keypad.

You should have a basic understanding of the following terms 
before proceeding:

microcomputer system components hardware
software input
CPU output
hardcopy DOS
applications software program files
data files  byte
Kb 
 Mb
primary storage ROM
RAM secondary storage
cursor function keys
booster keys  
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learning to use Windows

Chapter Performance:  When you have completed this chapter, 
you will be able to arrange and organize group windows on the 
desktop.  This chapter is for students that are not familiar with the 
Windows XP interface, and the Explorer for basic folder and file 
management.

Windows is an application program that operates in a graphical 
environment that allows MS-DOS microcomputers to function in 
a manner similar to Macintosh microcomputers. A graphical users 
interface has a WYSIWYG environment, which means what you 
see is what you get.  What is seen on the document screen is what 
is printed on paper.

A graphics-oriented environment is considered to be user 
friendly, and does not require the user to use special keystrokes 
and coding to cause the computer to function.  Instead, options 
are selected from a variety of menus and boxes.  Once you learn 
to use one Windows application, it will be easy to learn another 
because each one operates in a similar manner.

Windows may or may not be an operating system. Earlier ver-
sions of Windows were used in conjunction with MS-DOS and 
added several new dimensions to the disk operating system.  Win-
dows allows the user to run several applications at the same time.  
For example, spreadsheet, word processor, and database pro-
grams may co-exist simultaneously in the computer.  Users may 
switch from one application to the other, efficiently combining 
information to create striking letters, reports, and presentations.  
New Windows applications, such as Windows Vista, Windows 
XP, Windows 2000, Windows 98 and Windows 95 can be stand-
alone operational systems.  

starting the Computer and Windows Xp

Section Performance:  When you have completed this section, 
you will be able to start a computer and load Windows XP’s  
program into memory.

Now that you have a basic understanding of a computer system, 
you will learn to start the computer and the Windows XP  
application program.

If you are using a hard disk system, follow the steps in the section 
under the heading, Hard Disk Users.  If you are using a network 
system, follow the steps in the section under the heading,  
Network Users. 

Hard Disk Users

Typically, hard disk computers have enough storage capacity for 
you to store the Windows XP program and the data you create 
using those programs.  For the purposes of this course, however, 
you will learn to save your data to a USB flash drive.  (USB 
thumb drive)

1. Turn on the power to the computer and the monitor 
 (if necessary).

2. Sit back and relax while the computer goes through 
 the booting (starting) process.

 • The computer performs its normal checking procedures 
and loads the WINDOWS XP files into memory.  You 
may see some text appear and quickly disappear off the 
screen.  When the booting process is complete, informa-
tion will no longer disappear from the screen, and the 
disk drive lights will be turned off.

3. If your computer displays a menu with a number of choices, 
 locate the choice for Windows XP and follow the screen 
 directions to start the program.  

 • Momentarily, your screen display should look similar  
to the illustration in Figure 2.1.  The Desktop icons  
(pictures representing groups and/or 

 



19

fundamentals of draftting

Figure 2.1

  programs) that display on your screen may be different 
from the Desktop displayed in Figure 2.1.  If you see 
Recycle Bin, anywhere on the Desktop of  your screen, 
you have successfully started the Windows XP program.

4.  If your computer displays 

  C:\>          type win and tap 8  to start the program. 
                   (pertaining to Win 95)

5. If your computer starts the Windows XP program for you 
 automatically, check your screen display to see if it looks 
 similar to the illustration in Figure 2.1.  

6. Continue to the section, Defining the Windows XP 
 Environment.

Network Users

A network provides a way for many people to use the same ap-
plication programs.  Typically, these programs are stored in a 
large computer that may be in another room or even in another 
building from the one where your computer is located.  A cabling 
system connects your computer and, many other computers, to 
the large computer.  The network is a combination of software 
and hardware that enables you to access the programs and/or files 
that are stored on the large computer.

Each network system will have its own special procedures for 
gaining access to a program. We recommend that you have a 
written copy of the steps you need to take to log on to the  
network you are using.

1. Ask your instructor or lab manager for a copy of the log-on 
 procedures that you need to follow.

 • Most network systems require the user to enter a pass-
word to gain access to the system.  This password may 
be your initials, your social security number, or some 
other combination of letters and/or numbers that only 
you will use.

2. Follow the steps for logging on to the network system 
 you are using.

3. If necessary, select the Windows XP menu option to 
 select the Windows XP program.

 • If you have difficulty logging on, please ask for help.   
If you were successful, your screen display should look 
similar to the illustration in Figure 2.1.  The Desktop 
icons that display on your screen during a network boot 
may be different from the Desktop displayed in Fig-
ure 2.1.  If, however, you see the words, Recycle Bin, 
anywhere your screen, you have successfully started the 
Windows XP program.

Defining the Windows XP Environment

When you have completed this section, you will be able to identify 
the parts of a window.

The Windows XP environment includes many components.  The 
components that you will need to know before using A+CAD are 
explained in this section.

This book was written in reference to Windows XP, however.
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identifying parts of a Window

A window is a rectangular section on the screen that contains 
pictures and information that you use when performing tasks.   
A window is the area where you view an application or docu-
ment.  You may be able to see several windows on your screen  
at the same time.

Typically, when you start Windows XP, the Desktop displays 
shortcut icons, these are generally “start” icons for the most 
frequently used programs or folders.  The My Computer icon ac-
tivates a window that contains other smaller windows.  Typically, 
the smaller windows represent a group of application programs 
and are, therefore, called group windows.  Within each group 
window, you will find pictures with names below them.  The 
pictures are called icons and are used to represent programs and/
or documents.  

You need to know what to call the various parts and/or contents 
of a window to enable you to efficiently use Windows XP and 
the A+CAD program.  Figure 2.2 identifies the windows parts.  
Locate each window part in Figure 2.2 and study the definition in 
the following list before continuing.

application  A computer program used to perform a task 
such as creating a drawing.

Control Contains menu items that help you organize 
menu icon and size the windows on your screen.

Desktop          Main window containing My Computer and 
other frequently used icons and/or program  
applications.

Explorer File management tool within Windows XP  
(previously File Manager).

group window A window containing a collection of program 
applications. 

 Figure 2.2

parts of a Window (continued)

icon A graphic representation (picture) for vari-
ous items in Windows.

2.  My Computer icon Contains icons to disk drives, printers 
     and networks (hard

Maximize/Restore Used to enlarge and restore the active win-
dow to and from filling the entire screen.

menu bar A list of items or commands.

Minimize/Restore Used to reduce and restore the active win-
dow to and from the taskbar.

scroll arrow Used to move one line of information at a 
time into view within the window.

scroll bar Used to move up, down, left, or right in a 
document or window.

Scroll box Used to move to a general location in a 
document or window.
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Taskbar/(Restore) Memory collection for current running  
programs.  Click to restore.

title bar Displays the name of an application or 
document.

Window A rectangular area that contains a software 
application or a document file.

Identifying the Desktop

The desktop is the screen background for Windows XP.  It is 
similar to the surface of a desk.  It is the part of the screen where 
objects are placed, similar to the placement of pieces of paper and 
pencils or pens on a desk.  

Sometimes your computer screen desktop may display one open 
window, like having one piece of paper on your office desk.  
Sometimes your computer screen desktop may display several 
open windows of various sizes, like having several pieces of pa-
per of various sizes on your office desk. Also, just like your office 
desk, on rare occasions the desktop may be empty.

identifying the mouse pointer

A mouse is a hardware device that, when moved across a desk 
surface or mouse pad, positions a pointer, usually in the form of 
an arrow, on the computer screen.  It is the primary means used 
for selecting items (i.e. command buttons or menus) and for mov-
ing and sizing windows.

Typically, the mouse is held between the thumb and ring finger, 
allowing the index and middle fingers to operate the buttons on 
top of the mouse.  A pointer on the screen moves in combination 
with the movement of the mouse on the pad or desk surface.

1. Locate the mouse pointer arrow on your screen by moving 
 the mouse forward, backward, or from side-to-side on the 
 mouse pad and watching the screen display.

2. Continue to move the mouse on the mouse pad and notice 
 how the pointer moves proportionately on the screen.  Repeat 
 this step until you feel comfortable moving the mouse and 
 locating the pointer on the screen.

 • Rotating the mouse in small circles on the mouse pad in 
any direction causes the screen pointer arrow to move in 
small circles on the screen.  

3. Lift the mouse up off the pad and rotate the mouse in the air, 
 noticing that the arrow pointer does not move on the screen.

4. Return the mouse to a new location on the pad and rotate 
 once more, noticing that now the arrow pointer moves 
 on the screen.

 • You can relocate the mouse on the pad without affecting 
the arrow on the screen by lifting the mouse off the pad 
before relocating it.

The mouse arrow pointer may be used to select a specific symbol, 
box, word, or picture on the window.  Study the following list of 
terms and their meanings so you will understand what to do with 
the mouse when you encounter these terms in the instructions in 
this book.

Click To quickly tap and release the left  
mouse button.

Double-click Click (tap) the left mouse button twice  
in rapid succession.

drag Hold down the left mouse button while you 
slide the mouse on the pad.

point Slide the mouse (without holding down the  
button) until the tip of the pointer rests on the 
item of your choice.

Pick A pick is a synonymous with click.
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HELPFUL HINT:  Mouse Pointer

You may notice that occasionally the mouse pointer 
disappears from the screen.  This happens when it has not 
been used for a few minutes.  A slight movement of the 
mouse will cause the pointer to reappear on the screen.

Working with Windows XP

Section Performance:  When you have completed this section, 
you will be able to manipulate the Windows application to orga-
nize the desktop.

selecting the Control menu

Selecting the Control-menu icon at the left edge of the title bar 
displays a menu that contains commands that enable you to 
change the size of the active window, switch to a different  
window or program and exit the Windows program.  Every  
window has a Control-menu icon in the title bar.         

HELPFUL HINT:  Active Windows

Only one window can be active at a time and only one 
icon within a window can be active at a time. The tech-
nique to activate a window is very easy; simply click 
anywhere within a window to activate it. Similarly, an 
icon can be made active by clicking one time anywhere 
on the icon within the active window.

This concept is important because once a window or icon 
is activated, any command that you select will be carried 
out on the active window or icon.

1. To do file management you must first go to the “start” 
 button located in the lower  corner of your screen.  

2. Pick start.  

 • A vertical menu pops up.  (See figure 2.3)
 
3. Scroll up and pick programs and then pick accessories.

 • A second and then a third vertical menu appears.   
(See figure 2.4)

4. Pick Windows Explorer.  

• Your file manager dialog box appears.  (See figure 2.5)
  

  

Figure 2.3
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 Figure 2.4

             

 Figure 2.5

5. Locate the title bar near the top left of the Explorer window.

6. Point to the Control-menu icon by moving the mouse 
 pointer to the icon until the tip of the pointer is on top 
 of the icon.  

 • Refer to Figure 2.2 for help in locating the  
Control-menu icon.

7. Click the left mouse button once to display the 
 pull-down menu.

8. Study the list of commands on this menu.  

 • These commands are used to help you organize the  
windows on the desktop. Notice that some items on  
the list appear in dark print while other items appear 
in light print.  The dark items are the ones you can use 
now, but the light items are not available to you at the 
present time.

9. Again, point the arrow to the Control-menu icon at the left 
 of the title bar and click the left mouse button once.

 • The pull-down menu disappears when the left mouse 
button is moved and clicked again.

10. Hold down the alt key on the keyboard and tap the 
 spacebar to open the Explorer Control-menu.

 • Windows provides several methods for selecting most 
items.  Now you know how to select the Control-menu 
using the mouse and using the keyboard.

11. Move the mouse pointer so that the arrow displays near 
 the center of the desktop and click.

 • Now you know how to close the menu by pointing to 
two different places on the desktop and clicking.

12. Point to the Control-menu icon and double click.

 • Double clicking on the Control-menu icon is a shortcut 
for selecting the Close command.
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2. selecting menus from the menu Bar

Windows XP uses the same menu names for common functions 
to make it easy for you to learn new Windows based applications.  
Learning to use the Explorer menus will make it easier to learn to 
use A+ CAD menu.

1. Start your computer and open the Windows XP program.  
 If necessary, refer to the previous section on Starting the 
 Computer and Windows XP.

2. If necessary, go to the windows Explorer and open t
 he Explorer window.

3. Move your pointer to the drive letter for your USB 
 flash drive.

Locate the menu bar directly below the title bar. The menu bar 
contains the File, Edit, View, Favorites, Tools and Help menus.  
You may select a menu in one of two ways:  

	F pointing to the menu and clicking

	F holding down the Alt key and tapping the under-
lined letter of the desired menu name.  

5. Move the pointer to File and click to display the 
 pull-down menu.

6. Point to Edit and click.  Briefly read the pull-down menu.

7. Hold down the alt key and tap v.  Release the Alt key.

 • The View pull-down menu appears on the screen.  

8. Briefly read the selections.  Tap the alt key and the 
 menu disappears.

9. Hold down the alt and tap h.  Release the Alt key 
 to select the Help menu.

10. Briefly read the selections.  Tap the alt key and 
 the menu disappears.

11. Select each menu by pointing to the command 
 word and clicking.

12. Select each menu by holding down the alt key 
 and tapping the underlined letter. 
 
13. Repeat the steps until you feel confident in selecting 
 a menu using the mouse and the keyboard.

Now that you know how to select menus, you will want to know 
how to select a command from a menu.  Let’s experiment with 
the USB flash drive.  (It will check the information on your per-
sonal diskette.)  

1. Use one of the previous methods to select the File menu, 
 then pick the drive letter assigned to the USB flash drive”

2. Point to Properties and click to select the command.

 • The “Properties” dialog box displays.  This shows the 
amount of data stored on your USB flash drive.  Do not 
make any changes or selections in the box at this time.

 • If we had just made selections within this dialog box  
an OK here would enact the changes.   

1. Click the Cancel button to cancel the command.

 • No changes were made.  If you “cancel” a command, 
no changes are made.  You should “cancel” each of the 
experiments below.

4. Select the File menu again.

5. Type  r  to select Properties, and click Cancel to cancel 
 the command.

6. Select the File menu one more time.
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7. Tap 6 until Properties is highlighted and tap enter 8  
 to select the command.

8. Click Cancel to cancel the command.

Now you know how to use three methods for selecting com-
mands from a pull-down menu.  Pull-down menu commands may 
be selected by

	F moving the pointer to the desired command  
and clicking

	F typing the underlined letter of the desired command

	F  using the 6  or h  arrow keys to highlight the  
command and tapping Enter 8  to execute  
the command.

Using Minimize/Restore and Maximize/Restore 

One of the advantages of working with Windows is that you can 
change the size of a window located on the desktop.  If you are 
working with one window only, why not make it large enough to 
fill up the entire screen so you can see all of the information in 
the window?  If you have several windows open on the desktop, 
but only need to work with one, why not make the others very 
small (the size of a button) and get them out of your way?  You 
will learn to use the minimize button to change the size of a win-
dow to a taskbar box (icon), and you will learn to use the maxi-
mize button to change the size of a window to fill the desktop.

Minimize/Restore. The Minimize button is the first button at the 
right end of the title bar. It is used to shrink the active window to 
a symbol called a taskbar box.  Minimize is commonly used when 
several applications are running at the same time and the user 
wishes to view an application window different from the one cur-
rently displayed on the screen.  Minimizing the window does not 
close the program; the program is still running in the computer’s 
memory and is physically present down on the taskbar.  The task-
bar is usually located at the bottom of the screen and is connected 
to the start engine.  We will talk more about the Start Engine or 
the Rev Engine later.

Refer to Figure 2.2 for help in locating the Minimize button.

1. Point to the Minimize button at the right of the Explorer 
 title bar and click.  

 • The Explorer window disappears and is placed on the 
taskbar near the bottom of the desktop.  

 • If the taskbar is not currently visible, move your mouse 
cursor to the extreme bottom of the screen and the 
taskbar will become visible.  This display will list all 
the programs currently running and should include your 
reduced Explorer.  (Your machine can run numerous 
programs at one time; the number depends upon the 
amount of memory available.)

2. Point anywhere on the Explorer box.

3. Click on the box to again display the Explorer Control 
 Menu box on the screen.  This is one example of 
 restoring a window.

 • This is the same menu list you saw previously.  Mini-
mize the Explorer again.  This time we will use the re-
store command to get back to the Explorer.  The Restore 
command is used to restore the Explorer window.

4. Point to the Explorer box and right-click.  Move your 
 pointer to restore the Explorer window to its previous size.

 • Notice that the box on the taskbar no longer displays 
near the bottom of the desktop, but restore also  
restored the group windows that were open on  
the Explorer window.

Maximize/Restore. The Maximize button is used to enlarge the 
active window to the size of the entire work space on the desktop.  
Often an application is presented to the user on less than a full 
screen.  Clicking on the Maximize button will enlarge the applica-
tion window to fill the work space.
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Refer to Figure 2.2 for help in locating the Maximize button.

1. Point to the Maximize button at the end of the 
 Explorer title bar.

 • If you do not see the Maximize button at the end  
of the title bar, your window is already at its  
maximum size, and you should skip to step 3.

2. Click on the Maximize button to enlarge the window 
 to fill the desktop. 

3. Point to the Minimize button and click.

4. Double click on the Explorer title bar to restore the 
 window to its previous size.

 • This is another way to maximize a window.   
Now hit the minimize button.

 
5. Click on the Recycle Bin window on your Desktop 
 to make it the active window.

6. Point to the Maximize button on the Recycle Bin window 
 title bar and click. Now go to the taskbar and click 
 the Explorer box.

 • Now the Explorer window fills the desktop.  Where is 
the Recycle Bin?  It is behind the Explorer window fully 
maximized but underneath the Explorer.  You now have 
windows stacked like a stack of paper on your desk.  

restore (General). The Restore button is used to reduce the ac-
tive window to the previous size. The Restore button is used to 
reduce from maximized and enlarge from minimized (taskbar) 
and is the second button at the right end of the title bar. It is used 
to shrink the active window to a smaller size window.  Restore 
is commonly used when several applications are running at the 
same time and the user wishes to view an application window dif-
ferent from the one currently displaying on the screen. Restoring 
the window does not close the program; it just reduces the size of 
the current window.

Sizing a Window

In addition to minimizing and maximizing a window, you can 
change a window’s size to just about any size you want.  If you 
are trying to compare the contents of one window with the con-
tents of another, why not make them both small enough to display 
them side by side so you can see information in both windows at 
the same time?  

You will learn to change the size of a window by pointing to the 
window border and dragging the border to the desired location.

 

1. If necessary, reactivate the windows Explorer.

2. If necessary, restore the Explorer window to a 
 smaller sized window.

3. Point to the border at the right edge of the Explorer window 
 until the pointer changes to a double-headed arrow (n).

4. Hold down the left mouse button and drag the mouse to the 
 left to bring the border in about one inch towards the center 
 of the desktop, and release the mouse button.

 • The size of the window changes.

5. Point to the border at the bottom of the Explorer window 
 until the pointer changes to a double-headed arrow (n).

6. Hold down the left mouse button and drag the mouse upward 
 on the pad to bring the border up about one-half inch, and 
 release the mouse button.

7. Repeat this procedure to change the size of the 
 Recycle Bin window.

8. Now try to drag the window borders to their 
 original positions.
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 • It’s okay if you are unable to make them exactly like 
they were previously.

You can change the size of a window in two directions at the 
same time.  Positioning the double-headed arrow to one of the 
corners and dragging diagonally inward or outward enables you 
to change the size of two sides of a window simultaneously.

1. Point to the lower, right corner of the Explorer window until 
 the pointer changes to the double-headed arrow, hold down 
 the left mouse button, drag the border in and up towards the 
 center of the window about one inch, and release the button.

2. Point to the lower, left corner of the Recycle Bin window 
 until the pointer changes to the double-headed arrow, hold 
 down the left mouse button, drag the border in and up 
 towards the center of the window about one-half inch, 
 and release the button.

 3. Using the previous procedure, return the borders on the 
 Explorer and Recycle Bin window to their approximate, 
 original positions.

arranging Windows

You can arrange the windows on your desktop by using com-
mands available on the windows menu, or you can manually 
move your windows to a different location on the desktop.

Cascading.  Cascading windows arranges open windows in an 
overlapping fashion on the Desktop so that the title bar from each 
window displays.  Cascading is useful when you are working 
with a large number of open windows.

REMEMBER!  You may substitute other windows if the window 
names in this textbook do not match the window names displayed 
on your screen but make sure that the windows are open.

1. Point to Taskbar at the bottom of the screen and right-click.

2. Move pointer up the menu to cascade and left-click.

 • Momentarily, the windows display in a cascading fash-
ion with the active window on top.  The title bar for each 
window is visible.

tiling.  Tiling windows arranges open windows on the Desktop 
window like tiles on a floor or counter top.  Tiling is useful when 
you want to see all program windows at the same time.

1. Point to Taskbar at the bottom of the screen and right-click.

2. Move pointer up the menu to tile.  Here you have two 
 possibilities.  Tile vertically puts the windows side by side 
 (vertically.)  Tile horizontally puts the windows on top of 
 the other,(stacks them horizontally.)

 • Momentarily, the windows display in a tiled fashion 
with the active window title bar displaying in a different 
color or a darker shade than the title bars on the other 
windows.

moving.  If you are not satisfied with Tiling or Cascading,  
you can move the windows to the location of your choice  
within the Desktop.

1. Move the mouse pointer to the word, Recycle Bin, in the 
 title bar of the Recycle Bin window.

2. Hold down the left mouse button and drag the window so 
 that it partially covers the Explorer window, and release the 
 mouse button.

  * The key to moving a window is to be sure the mouse 
pointer is pointing to the name on the title bar.

3. Use the same procedure to move the Recycle Bin window 
 back to its previous location, remembering to point to the 
 name in the title bar and drag.
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4. Move the Explorer window to the center of the desktop by 
 pointing to the title bar and dragging.

5. Point to the taskbar at the bottom of the screen 
 and right-click.  

6. Move pointer up the menu to minimize all windows 
 and left-click.  They are all back on the Taskbar now.

using the scroll Bars

A scroll bar is a tool that allows the user to move the contents of 
a window up or down, left or right. This action is called scrolling.  
A window may have one, two, or no scroll bars displaying at a 
time.  If a window has more information than can be displayed in 
the vertical direction of the window, a vertical scroll bar appears 
automatically.  If a window has more information than can be 
displayed in the horizontal direction of the window, a horizontal 
scroll bar displays.  

Refer to Figure 2.2 for the location of the vertical and horizontal 
scroll bars.

1. If necessary, click on the Explorer window to make 
 it the active window.

2. Select View; verify that the left window selects the A: 
 (A: drive), verify that either the large or small icons are 
 checked and verify that the check mark displays in front of 
 Auto Arrange.  If it does not, select Auto Arrange.

If necessary, resize the window by moving the borders until the 
window is small enough for scroll bars to appear across the bot-
tom and inside the right border.

3. Point to the down-pointing arrow on the vertical scroll bar 
 and click the left mouse button several times to see the 
 information in the window scroll up.

 * Pointing to the down-pointing arrow tells  
Windows XP that you want to see what is  
down below the window view.

4. Watch the scroll box in the vertical scroll bar move as you 
 click the up-pointing arrow in the vertical scroll box several 
 times.  (Be careful!  Do NOT click the Maximize button.  If 
 you did, click the Restore button, and then repeat this step.)

  • The scroll box moves along the vertical scroll bar as you 
click the arrow.  Pointing to the up-pointing arrow tells 
Windows XP that you want to see what is up above the 
window view.

5. Locate the scroll box in the horizontal scroll bar.

6. Click on the arrow at the opposite end of the scroll box in the 
 horizontal scroll bar and watch the box move along the bar
 as the information in the window moves to the left or right.

You can scroll horizontally or vertically by dragging 
the scroll box along the bar.

1. Point to the scroll box in the vertical scroll bar, drag the box 
 to the top or bottom of the bar, and release the button.

 • An outline of the box displays during the dragging 
process.   When the mouse button is released, the actual 
scroll box replaces the outline.

2. Drag the scroll box in the horizontal scroll bar to one 
 end of the bar.

 • Dragging to the left or right end of the horizontal scroll 
bar scrolls to the left or right edge of the window.

3. Practice using the scroll arrows and scroll bars until 
 you can use them efficiently.

4. Double click on the Control-menu box at the left of the 
 Explorer title bar. Again, this closes the Explorer window.

5. When you wish to quit, pick Start, (lower left corner of the 
 screen.)  Pick the Shut Down button from the fly-up menu.  
 Make sure a click is made to “shut down windows”, and 
 click the OK button to exit the Windows program.
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6. If necessary, remove any floppy disks and turn off the power 
 to the computer and the monitor.

Test your understanding of the concepts by completing the 
Checking Your Mastery items.

Checking Your Mastery
Circle T (True) or F (False) for each one of the following items.  
The correct answers may be found on the next page.

T F 1. A window is a rectangular area that contains  
smaller windows and/or icons.

T F 2. The desktop is the main surface in Windows XP  
that positions a pointer on the screen.

T F 3. A picture that represents a program or a document is 
called an icon.

T F 4. You can use the mouse pointer to select a command 
from a menu box or the menu bar.

T F 5. You can exit the Windows XP program by selecting 
Start Engine, selecting Shut Down and selecting Yes 
to the Shut Down The Computer toggle.

T F 6. The Minimize button is selected to help you mini-
mize errors when changing the size of a window.

T F 7. The Restore button is selected to restore the active 
window to its previous size.

T F 8. Tiling windows arranges windows in an overlapping 
fashion enabling you to read the title bar of each 
window, but not allowing you to see the contents of 
each window.

T F 9. The size of a window may be changed in two direc-
tions at once.

T F 10. Scroll bars will not be active when all of the infor-
mation in a window is in view.

Answers to Checking Your Answers

1. T (p. 12) 6. F (p. 20) 
2. T (p. 12, 13) 7. T (p. 20, 21)
3. T (p. 11, 12) 8. F (p. 23)
4. T (p. 14) 9. T (p. 22) 
5. T (p. 25) 10. T (p. 24)

folders
Objective:  By the end of this exercise you will be  
understand the use of file folders.

Folders are like filing cabinet drawers.  They are separate areas 
or containers that can hold many files.  Folders can be made as 
a simple WINDOWS function, created through the Windows 
XP software.  Regardless of how they are created, their function 
remains the same.  CAD users not only place specific kinds of in-
formation within folders, but also many software’s come divided 
into folders.  It is crucial therefore, that a CAD user be able to 
create, remove, or move information from one folder to another.

The purpose of this book is to get you acquainted with folder 
characteristics through the use of Windows graphical user 
interface (GUI).

Let’s get to the same point of departure.  Remember, when start-
ing a work session (or booting the machine), the machine should 
boot automatically into Windows XP.  Our objective is to get to 
the Desktop screen.  From there go through the start engine, to 
programs, to accessories and then to Windows Explorer.  We 
should now be ready to create some folders.
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Creating folders

Now, once in the Explorer, determine where you want the new 
folder to be made. You do this by selecting a drive letter in the 
left window (i.e., (A:), (C:), etc.). For our purposes here we will 
use the drive letter assigned to the  USB flash drive.

1. Select the USB flash drive on which the folder will 
 be created.

2. Pick File.

 • Move to New.  Then move to Folder and left-click.

3. Automatically in the right side screen, a highlighted and
 blinking “new folder” appears.

 • This blinking cursor is telling you that it’s ready to 
receive text.

4. Type in a name for your folder.  (Type in your first name.)

5. After you’ve entered a name, Pick your left mouse button 
 or tap the Enter key on your keyboard.

 • Note that your name now appears in the right-side 
Directory window.  Also note that folders have no file 
extension; nothing appears after your first name.  The 
shape of the folder icon is also different than the files 
icon.  (If you have any files on your USB flash drive, 
compare the icons.)

Now let’s create another folder using your last name.  Repeat 
steps 2 through 6 again.  You should have two folders on your 
USB flash drive: now.

selecting/opening a folder

selecting a folder is very easy.  Simply move your cursor to the 
folder you want activated, and click.  Any menu command will 
now be enacted upon this selected drive.

opening a folder is as easy.  This requires moving your pointer 
to the folder you want activated and double-clicking on the name 
of the folder.   This will open another window that displays the 
contents of the folder you just clicked on. 

1.   Double-click (open) the folder of your last name.

 • A new Directory window appears.  Notice the top label 
shows the letter of the drive, and the name of the folder.  
For our exercise, the folder is called your LASTNAME.

2. Pick the USB flash drive at the top of the (left) 
 Directory window.

 • The Directory window disappears, returning you to 
viewing the drive window.

Copying information Between folders

Objective:  By the end of this exercise you will be able to copy or 
move files from one folder to another.

Because CAD operators use folders to categorize their work, it is 
essential that you learn how to copy or move information from 
one folder to another.

select the desired drive

Return to the Explorer dialog box.

1.   
Activate (open) the folder we created earlier that we 
called your first name.

 • A two-part Directory window appears.  The left side of 
the Directory window indicates the name of the folder 
on the drive.  The right side displays the name of the 
files within the folder.
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2.  Create a few new text files in the folder.  Move to the 
File menu, move to NEW, left-click on “new text docu-
ment”. Do this a few times to create multiple files.  You 
do not have to name the files for this exercise. 

Select the desired files

1. Depress the control key on the keyboard while picking the 
 files you want to copy with your mouse. (Depressing the 
 control key after selecting the first file allows you to select 
 more than one file at a time.) Select the text documents that 
 we created in the previous step.

2. After selecting the files you want to copy, pick Edit from 
 the Explorer menu bar and pick the Copy  option.

 • The files that you just selected have just been sent into 
memory (onto the clipboard) to be retrieved upon the 
very next paste.

3. Now select the last name folder that we made earlier 
 in the chapter.

4. Once the last name folder is selected, pick Edit from the 
 Explorer menu bar and pick the Paste option.  New copies 
 of the previously selected files will now be made into the 
 last name folder.

 • You will be able to see the names of the selected files as 
the machine duplicates them under the last name folder.

deleting folders 

If you remember that a folder is like a file drawer within a cabinet 
then it is easy to understand that you may want to empty the 
folder (drawer) when you no longer have use for the files stored 
there, you should also remove the unwanted folders.  Deleting 
unused or unwanted folders saves space on the disk or hard disk 
and makes finding usable information much easier.

In the Windows XP environment, deleting a folder is very quick 
and very easy. This convenience, however, can be highly detri-

mental if you make an error or do not understand that all files 
within the folder are deleted and therefore destroyed when a 
folder is deleted.

Objective:  By the end of this exercise you should be able to 
successfully delete a folder from your disk.

In the preceding pages, we created several new folders on the 
USB flash drive:.  Let’s experiment with the delete Folder 
process by using your LASTNAME folder.  

1. Go to the Explorer window.

2. Make sure your USB flash drive is active.

3. Pick your USB flash drive in the left window.

4. Select the name of the folder you wish to delete 
 (Pick your last name folder in the left column.)

 • Notice that the files on the right side of the dialog box 
change as you select different directories on the left side.  
All files displayed on the right side will be deleted and 
destroyed when you delete the folder they are in.

5. Once you have selected the appropriate folder 
 (your LASTNAME for this exercise).

6. Pick File, then Delete...

 • A horizontal dialog box should appear.  After  
picking the folder for deleting in the left window  
the right window should display contents of the  
folder as the title states.

7. Pick YES

 • This is a Confirm Folder Delete dialog box.  This is the 
machines way of warning you that if YES, or YES TO 
ALL is picked, the folder displayed will be removed - - - 
along with all files in it.
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8. Pick YES or YES TO ALL

 • Notice that all of the file names in the folder are entered 
to the right of the folder. As the file names appear and 
quickly disappear, the files are deleted.

After the machine has finished deleting all files within the  
selected folder, the names of the folders are also deleted.  If 
needed, reselect your USB flash drive icon at the top left of the 
Explorer and check what information remains on your USB flash 
drive.  Your LASTNAME folder should be gone - - - along with 
any files that were in it.

summary Question
Are you comfortable with creating new folders and copying files 
into them?  Since you cannot remove files or folders that do not 
exist, you may wish to review this section several times until you 
can create, copy information into, and delete folders without fear 
of deleting and therefore destroying files and folders you want  
to keep.
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Chapter 4

geometric Construction
 
The construction of geometric shapes is the foundation of draft-
ing.  Drawings created whether complex or simple are made up 
of some variety of geometric forms.  It is critical that a drafter has 
a solid understanding of the geometric construction to create new 
drawings and modify existing ones.  There are two basic types 
of geometric forms two-dimensional (2D) and three-dimensional 
(3D).  2D forms are created with lines, squares, polygons, circles, 
triangles, ellipses, and other free forms.  3D forms are also cre-
ated using the same forms as two-dimensional, but differ in that 
3D forms real world view of depth, height, and width.  See figure 
to see the common geometric forms and terminology.

important note:
Included in this chapter are step by step instructions to for 
students to create basic geometric objects using the A+CAD tech-
nology.  To open A+CAD and follow the step by step instructions 
pick the Start button at the very lower left corner of your screen, 
then choose Programs, next click on The CAD Academy, and 
then A+CAD 2008. Alternatively, double-click the A+CAD 2008 
icon on the desktop to open the program. 

Basic shapes and terms

lines
 
straight lines: is the shortest distance between two points

Drawing lines
A line consists of two points: a start point and an endpoint. You 
can connect a series of lines, but each line segment is considered 
a separate line entity.

To draw a line
1. Do one of the following:
     • Choose Insert > Line. 
   • On the Draw 2D toolbar, click the Line tool     

• Type line and then press Enter. 

2. Specify the start point. 

3. Specify the endpoint. 

4. In the prompt box, choose Done to complete the command. 

 

Start point (A) and endpoint (B).

Curved lines: can be in the form of an arc, circle or any other 
irregular curve

There are many tools that are used to create curved lines.  Two 
common ways other than an arc and a circle include freehand 
sketches and splines.

Creating freehand sketches
 Before you begin creating a freehand sketch, you must set the 
length, or increment, of each segment.  After you specify the 
length of the sketch segments, the crosshairs change to a Pencil 
tool. Your freehand sketch is not added to the drawing until you 
“write” the sketch into your drawing. 

To create a freehand sketch:

1. Do one of the following: 
  Choose Insert > Freehand. 
  On the Draw 2D toolbar, click the Draw Freehand tool   
  Type freehand and then press Enter 
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2. Specify the length of the sketch segments. 

3. Click the mouse button to place the Pencil tool 
 on the drawing to begin sketching   

4. Move the pencil image to draw a temporary freehand sketch. 

5. Click the mouse button to lift the pencil up to stop sketching. 

6. In the prompt box, choose Write, Then Resume to write 
 the temporary freehand sketch into the drawing. 

   
 

A freehand sketch consists of individual line entities or a 
polyline.

drawing splines
A spline is a smooth curve defined by a set of points. You can use 
splines to create sculptured shapes such as the cross section of a 
turbine blade or an airplane wing.

To draw a spline:

1. Do one of the following: 
  Choose Insert > Spline. 
  On the Draw 2D toolbar, click the Spline tool   

Type spline, and then press Enter. 

2. Specify the first point of the spline. 

3. Specify the second point of the spline. 

4. Specify as many more points as you want. 

5. When you have finished, press Enter. 

   

parallel lines: lines that maintain equal distance apart 
throughout the length

Making parallel copies
You can use the parallel feature to copy selected entities and align 
them parallel to the original entities at a specified distance. You 
can make parallel entities using arcs, circles, ellipses, elliptical 
arcs, lines, two-dimensional polylines, rays, and infinite lines.

Making parallel copies of curved entities creates larger or smaller 
curves, depending on which side of the original entity you place 
the copy. For example, placing a parallel copy of a circle outside 
the circle creates a larger concentric circle; positioning the copy 
inside the circle creates a smaller concentric circle.

To make a parallel copy by specifying the distance:

1. Do one of the following: 
 • Choose Modify > Parallel. 
 • On the Modify toolbar, click the Parallel tool   
 • Type parallel and then press Enter. 

2. Specify the distance by selecting two points or 
 by entering a distance. 

3. Select the entity to copy. 

4. Specify on which side of the entity to place the parallel copy. 

5. Select another entity to copy, or press Enter to complete 
 the command. 

                       

                         Result     
 
To make a parallel copy, specify the distance between copies by 
entering a distance or selecting two points (A and B), select the 
entity to copy (C),
and specify on which side to place the copy (D).
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intersecting lines: are lines that cross or meet at one and 
only one point 

Intersection Snap tool
The Intersection Snap tool snaps to the actual intersection in 
three-dimensional space of any combination of entities. You 
can snap to the combination of an arc, circle, line, infinite line, 
polyline, ray, ellipse, elliptical arc, spline, hatch pattern, polygon 
mesh, or polyface mesh. You can also snap to an intersection 
point within a single entity, including a polyline or spline. 

To set the Intersection Snap:

Do one of the following:
  Choose Settings > Entity Snap > Intersection Snap. 
  On the Entity Snaps toolbar, click the 
  Set Intersection Snap tool  
  Type intersection and then press Enter. 
   
 

To snap to an intersection, select the intersection (A).
point of intersection: a specific point at which two or more lines 
cross or meet 

perpendicular lines: where lines intersect at 90 degrees or a 
right angle

Perpendicular Snap tool
Use the Perpendicular Snap tool to snap to the perpendicular 
point of another entity. You can snap to an arc, circle, ellipse, 
line, polyline, infinite line, ray, spline, hatch pattern, or edge of a 
plane to form a perpendicular alignment with that entity or with 
an imaginary extension of that entity. 

To set the Perpendicular Snap:

Do one of the following:
  Choose Settings > Entity Snap > Perpendicular Snap. 
  On the Entity Snaps toolbar, click the Set 
  Perpendicular Snap tool   
  Type perpendicular and then press Enter. 

   

 To form a perpendicular angle (A) to an entity (B), select any-
where on the entity.

 
 
 triangles

equilateral triangle: all sides and angles are equal

Drawing polygons by side
The side polygon drawing method creates an equal-sided polygon 
defined by its center point and the distance to the midpoint of a 
side. You specify the number of sides, the center point, and the 
location of the midpoint of one side, which determines both the 
size and orientation of the polygon.
To draw a polygon by side:

1. Do one of the following: 
  Choose Insert > Polygon. 
  On the Draw 2D toolbar, click the Polygon, 
  Center-Side tool   
  Type polygon, and then press Enter. 

2. Type 3 to specify three sides for the polygon. 

3. Specify the center of the polygon. 

4. In the prompt box, choose Specify By Side, 
 and then press Enter. 
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5. Specify the midpoint of the side. 

  
                                                          
 

The center (A) and midpoint of one side (B).            
 Resulting polygon
 

isosceles triangle: one right angle and two equal sides 

To draw an isosceles triangle:

1. Choose Insert > Polyline

2. Pick starting point: type: 0,0  (then press Enter)

3. Press F8 to turn Ortho mode ON.  This forces the crosshairs 
 to move in vertical or horizontal directions only.

4. Drag the mouse to the right (0 deg.) and type: 
 3  (then press Enter)

5. Drag the mouse upward (90 deg) and type: 
 3 (then press Enter)

6. Type: 0,0  (then Enter) to connect the third 
 segment to the starting point.

Hit the Enter key to finish the command.

Resulting Isosceles Triangle

right triangle: has one angle of 90 degrees 
 
– Hypotenuse: the opposite side of the 90 degree angle 
  of the triangle
– Pythagoras’ Theorem: a 3-4-5 right triangle where a²+b²=c²

To draw a right triangle:

1. Choose Insert > Polyline

2. Pick starting point: type: 0,0  (then press Enter)

3. Press F8 to turn Ortho mode ON.  This forces the
  crosshairs to move in vertical or horizontal directions only.

4. Drag the mouse to the right (0 deg.) and type: 
 3 (then press Enter)

5. Drag the mouse upward (90 deg) and type: 
 4 (then press Enter)

6. Type: 0,0  (then press Enter) to connect the third 
 segment to the starting point.

7. Press the Enter key to finish the command.

Resulting Right Triangle
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scalene triangle: one right angle with no equal sides or angles

1. Use the same steps as in the Right triangle.

angles
 
acute angles: an angle that is smaller than 90 degrees
 

Acute Angle

right angle: an angle that measures exactly 90 degrees

 

Right Angle

obtuse angle: an angle that is larger than 90 degrees
 

Obtuse Angle

Complementary angles: are angles that add up to 90 degrees or 
a right angle

 

Complementary Angles

supplementary angles: are angles that add up to 180 degrees

 

Supplementary Angles

Creating angles
Creating lines or polylines that are at specific angles can be 
achieved by using polar coordinates.

Using relative polar coordinates makes drawing a square tilted  
at a 45-degree angle a simple task. Polar coordinates base the 
location of a point on a distance and angle from either the  
origin (absolute coordinate) or from the previous point  
(relative coordinate).

To specify polar coordinates, type a distance and an angle, sepa-
rated by the open angle bracket (<). For example, to use relative 
polar coordinates to specify a point 1 unit away from the previous 
point and at an angle of 45 degrees, type @1<45.

To draw the square tilted at a 45-degree angle:

1. Do one of the following: 
  Choose Insert > Line, and then respond  

to the prompts as follows, 
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  note: press the Enter key after each entry.
  Start the  Line command using the toolbar button   

2. Start of line: 4,5

3. Angle ? Length ? <End point>: @8.5<45

4.  Angle ? Length ? Follow ? Undo ? <End point>: @8.5<315

5. Angle ? Length ? Follow ? Close ? Undo ? <End point>: 
 @8.5<225

6. Angle ? Length ? Follow ? Close ? Undo ? <End point>: C
 Drawing a tilted square using the relative polar coordinates 
 method; enter C to close.

Resulting 45-degree tilted Square

Circles

Circle: a given set of points in a plane that are equal  
distant from a given point. 

Drawing circles
The default method for drawing a circle is to specify a center 
point and radius. You can draw circles using any of the following 
methods:

Center-Radius   
Center-Diameter  
Two points     
Three points   
Radius-Tangent-Tangent                                                     
Convert Arc to Circle   

To draw a circle by specifying its center and radius:

1. Do one of the following: 
  Choose Insert > Circle. 
  On the Draw 2D toolbar, 
  click the Circle Center-Radius tool 
  Type circle and then press Enter. 

2. Specify the center point. 

3. Specify the radius of the circle. 

   

Center point (A) and radius (B).

Concentric circles: are two or more circles that have 
a common center point

   

inscribed circles: the largest circle that can be drawn 
inside a given figure
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Circumscribed circles: a circle that passes through 
all the vertices of the figure
  

Eccentric circles: are two or more circles that do not 
have a common center point
  

segment:  the small portion of the circle that is separated  
by a chord

Chord:  a line segment joining two points on a curve

diameter:  a straight line through the center of the  
circle connected to the circumference

radius:  the distance from the center of the circle  
to the edge or ½ of the diameter

Circumference:  the distance around the out 
side of the circle

Center:  a point located in the exact center of the circle

secant line:  a line passing through two points of a curve

tangent line:  a line that touches a curve at one point, without 
cutting across it. 

Vertex:  a point where two or more points meet, also 
called vertices

  

sector: part of a circle or the area between two radiuses 
with connecting arc “slice of pie”

arc: a part of the circumference of the circle 

Quadrant: one quarter of a circle

angle: two intersecting lines or line segments

   

regular polygons
 

square: all sides are equal and internal angles are 90 degrees
 
To draw a square:

1. Do one of the following: 
  Choose Insert > Rectangle. 
  On the Draw 2D toolbar, click the Rectangle tool   
  Type rectangle, and then press Enter. 

2. In the prompt box, choose Square. 
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3. Specify one corner of the square. 

4. Specify the length of one side of the square by selecting 
 its other end. The point you specify determines both the 
 size and alignment of the square.

     
   

  

Endpoints of one side of the square (A and B). Resulting square
 
rectangle: opposite sides are equal and internal angles  
are 90 degrees

Drawing rectangles
With A+CAD, rectangles are closed polylines with four sides. 
You draw a rectangle by specifying its opposite corners. The 
rectangle is normally aligned parallel to the current snap and 
grid alignment, but you can use the Rotated option to align the 
rectangle to any angle.

To draw a rectangle:

1. Do one of the following: 
  Choose Insert > Rectangle. 
  On the Draw 2D toolbar, click the Rectangle tool  
  Type rectangle, and then press Enter. 

2. Specify one corner of the rectangle. 

3. Specify the opposite corner of the rectangle. 

      

Opposite corners (A and B).      Resulting rectangle.
 

You can edit each side of a rectangle individually using the Edit 
Polyline tool on the Modify toolbar.   

You can convert the sides into individual line entities using the 
Explode tool on the Modify toolbar.  

You can control whether wide rectangle lines are shown filled or 
as outlines using the Fill tool on the Settings toolbar.  

You can also use the Rectangle tool to draw a square. Instead of 
specifying the opposite corners, you specify the length of one 
side and the alignment of the square.

rhombus:  all sides are equal

rhomboid:  opposite sides are equal

Trapezoid:  two sides are parallel

Trapezium:  no sides are parallel

pentagon:  five equal sides and equal angles

Hexagon:  six equal sides and equal angles

heptagon:  seven equal sides and equal angles

octagon:  eight equal sides and equal angles

drawing polygons
Polygons are closed polylines comprised of a minimum of three 
and a maximum of 1,024 equal-length sides. The default method 
for drawing a polygon is to specify the center of the polygon and 
the distance from the center to each vertex. You can draw a poly-
gon using any of the following methods:

Center - by vertex on the Draw 2D toolbar    
Center - by side on the Draw 2D toolbar   
Edge on the Draw 2D toolbar   
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The vertex polygon drawing method creates an equal-sided poly-
gon defined by its center point and the distance to its vertices. 
You specify the number of sides, the center point, and the loca-
tion of one vertex, which determines both the size and orientation 
of the polygon.

To draw a polygon by vertex:

1. Do one of the following: 
  Choose Insert > Polygon. 
  On the Draw 2D toolbar, click the Polygon, Center-

Vertex tool  
  Type polygon, and then press Enter. 

2. Type 5 (Pentagon) to specify five sides for the polygon. 

3. Specify the center of the polygon. 

4. Specify the vertex of the polygon. 
           

 The center (A) and vertex (B).  Resulting polygon
 

3d forms
 
sphere: a three dimensional object shaped  
like a ball

Creating spheres
You can create a sphere. The latitude lines of a sphere are always 
parallel to the xy plane of the current UCS; the central axis is 
always parallel to the z-axis. You position a sphere by specifying 
its center point. You determine the size of a sphere by specifying 
either its radius or its diameter.

-----------------------------------------------------------------------------
NOTE The sphere is created as a three-dimensional ACIS solid.
-----------------------------------------------------------------------------

To create a sphere:

1. Do one of the following: 
  Choose Insert > 3D Entities > Sphere. 
  On the Solids toolbar, click the Sphere tool   
  Type sphere and then press Enter. 

2. Specify the center of the sphere. 

3. Specify the radius or diameter. 

      
     
 

Center (A) and radius (B) of the sphere         Resulting Sphere                
 

To create a sphere as a three-dimensional surface:

To create a sphere as a surface instead of as a solid, 
the procedure is similar.

1. Do one of the following: 
  On the Draw 3D toolbar, click the Sphere tool   

Type a sphere and then press Enter. 

2. Specify the center of the sphere. 

3. Specify the radius or diameter. 

4. Specify the number of longitudinal sections that are 
 perpendicular to the xy plane. 
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5. Specify the number of latitudinal sections that are 
 parallel to the xy plane. 

Cube: contains six equal square plane faces, shaped like a dice 

Creating boxes
You can create a rectangular box, or cube. A box consists of six 
rectangular surface planes. The base of the box is always paral-
lel to the xy plane of the current UCS. You position the box by 
specifying either a corner or the center of the box. You determine 
the size of the box by either specifying a second corner and 
the height; defining the box to be a cube and then providing its 
length; or specifying the length, width, and height.
-----------------------------------------------------------------------------
NOTE The box is created as a three-dimensional ACIS solid.
-----------------------------------------------------------------------------
To create a box:

1. Do one of the following: 
  Choose Insert > 3D Entities > Box. 
  On the Solids toolbar, click the Box tool   
  Type box and then press Enter. 

2. Specify the first corner of the base. 

3. Specify the opposite corner of the base. 

4. Specify the height. 
   

First corner of the base (A), the opposite corner of the base (B), 
and the height (C).

To create a box as a three-dimensional surface:

To create a box as a surface instead of as a solid, 
the procedure is similar.

1. Do one of the following: 
  On the Draw 3D toolbar, click the Box tool  
  Type a box and then press Enter. 

2. Specify the first corner of the base. 

3. Specify the opposite corner of the base. 

4. Specify the height. 

Cylinder:  has straight sides and circular ends of equal size, 
shaped like a tube

Creating cylinders
You can create a cylinder defined by a circular base. The base of a 
cylinder is always parallel to the xy plane of the current UCS; the 
height of a cylinder is always parallel to the z-axis. You position 
a cylinder by specifying the center of the base. You determine the 
size of a cylinder by specifying either the radius or diameter of 
the base and the height.
-----------------------------------------------------------------------------
NOTE The cylinder is created as a three-dimensional ACIS solid.
-----------------------------------------------------------------------------
To create a cylinder:

1. Do one of the following: 
  Choose Insert > 3D Entities > Cylinder. 
  On the Solids toolbar, click the Cylinder tool  
  Type cylinder and then press Enter. 

2. Specify the center of the base of the cylinder. 

3. Specify the radius or diameter. 

4. Specify the height. 
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Center of the base (A), the radius of the base (B), 
and the height (C).

To create a cylinder as a three-dimensional surface:

To create a cylinder as a surface instead of as a solid, the proce-
dure is similar.
1. Do one of the following: 
  On the Draw 3D toolbar, click the Cylinder tool    

Type a cylinder and then press Enter. 

2. Specify the center of the base of the cylinder. 

3. Specify the radius or diameter. 

4. Specify the height. 

pyramid: has triangular sides that slope to meet in a point

Creating pyramids
You can create a tetrahedron (three-sided pyramid) or a four-
sided pyramid. The sides of the resulting pyramid can meet at a 
point (the apex) or can form a three- or four-edged top. The sides 
of a four-sided pyramid can also meet along a ridge defined by 
two points. The base of the pyramid is always parallel to the xy 
plane of the current UCS. You position the pyramid by specifying 
a corner of the base. You determine the size of the pyramid by 
specifying the base points and either the apex, the corners of the 
top surface, or the endpoints of the ridge.

-----------------------------------------------------------------------------
NOTE The tetrahedron and pyramid are created as three-
dimensional ACIS solids.
------------------------------------------------------------------------------
To create a tetrahedron:

1. Do one of the following: 
  Choose Insert > 3D Entities > Pyramid. 
  On the Solids toolbar, click the Pyramid tool  
  Type pyramid and then press Enter. 

2. Specify the first point for the base of the pyramid. 

3. Specify the second and third points. 
4. In the prompt box, choose Tetrahedron. 

5. Specify the apex of the tetrahedron. 
   

The first point (A), second point (B), and third point (C) of the 
base, and the apex (D).

To create a pyramid as a three-dimensional surface:

To create a pyramid as a surface instead of as a solid, 
the procedure is similar.

1. Do one of the following: 
  On the Draw 3D toolbar, click the Pyramid tool    

Type a pyramid and then press Enter. 

2. Specify the points as described previously. 
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Cone: has a circular base that tapers to a point perpendicular 
to the base

Creating cones
You can create a three-dimensional cone defined by a circular 
base and tapering to a point perpendicular to the base. The base 
of the cone is always parallel to the xy plane of the current UCS; 
the height of the cone is always parallel to the z-axis. You posi-
tion the cone by specifying the center of the base. You determine 
the size of the cone by specifying either the radius or the diameter 
of the base and the height.
-----------------------------------------------------------------------------
NOTE The cone is created as a three-dimensional ACIS solid.
-----------------------------------------------------------------------------
To create a cone:

1. Do one of the following: 
  Choose Insert > 3D Entities > Cone. 
  On the Solids toolbar, click the Cone tool   
  Type cone and then press Enter. 

2. Specify the center of the base of the cone. 

3. Specify the radius or diameter. 

4. Specify the height. 

   
 

Center of the base (A), radius of the base (B), and the height (C).

To create a cone as a three-dimensional surface:

1. Do one of the following: 
  On the Draw 3D toolbar, click the Cone tool  
  Type a cone and then press Enter. 

2. Specify the center of the base of the cone. 

3. Specify the radius or diameter. 

4. Specify the height. 
Torus: three-dimensional donut or ring shaped entity

Creating Torus
You can create a three-dimensional donut or ring-shaped entity 
known as a torus. The diameter of a ring is always parallel to the 
xy plane of the current UCS. A torus is constructed by revolving 
a circle about a line drawn in the plane of the circle and parallel 
to the z-axis of the current UCS. You position a torus by specify-
ing its center point. You determine the size of a torus by specify-
ing its overall diameter or radius and the diameter or radius of the 
tube (the circle being revolved).
-----------------------------------------------------------------------------
NOTE The torus is created as a three-dimensional ACIS solid.
-----------------------------------------------------------------------------
To create a torus:

1. Do one of the following: 
  Choose Insert > 3D Entities > Torus. 
  On the Solids toolbar, click the Torus tool  
  Type torus and then press Enter. 

2. Specify the center of the whole torus. 

3. Specify the radius or diameter of the whole torus. 

4. Specify the radius or diameter of the body of the torus. 
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Center (A) and radius of the whole torus (B), and the radius 
of the body (C).

To create a torus as a three-dimensional surface:

1. Do one of the following: 
  To create a torus as a surface instead of as a solid, the 

procedure is similar. 
  On the Draw 3D toolbar, click the Torus tool   

Type a torus and then press Enter.

2. Specify the center of the whole torus. 

3. Specify the radius or diameter of the whole torus. 

4. Specify the radius or diameter of the body of the torus. 

5. Specify the number of longitudinal sections that 
 are perpendicular to the xy plane. 

6. Specify the number of latitudinal sections that are 
 parallel to the xy plane. 
 

applying Basic geometric Construction
 
tangent line: 
Tangent Snap tool
Use the Tangent Snap tool to snap to the tangent point of another 
entity. You can snap to the point on an arc, ellipse, spline, or 
circle that, when connected to the previous point, forms a line 
tangent to that entity.

To set the Tangent Snap:

1. Do one of the following:
  Choose Settings > Entity Snap > Tangent Snap. 
  On the Entity Snaps toolbar, click the Set Tangent 
  Snap tool   
  Type tangent and then press Enter. 
   

 To snap to a tangent, select the entity near the tangent point (A).

tangent arc: an arc that touches another curve or line 
at one point

To draw a circle tangent to existing entities:

1. Do one of the following: 
  Choose Insert > Circle. 
  On the Draw 2D toolbar, click the Circle 
  Radius-Tangent tool   

Go to step 3. 
  Type circle and then press Enter. 

2. In the prompt box, choose Radius-Tangent-Tangent. 

3. Specify the radius of the circle. 

4. Select the first entity to which to draw the circle tangent. 

5. Select the second entity to which to draw the circle tangent. 
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Radius of circle (A) and tangent lines (B) and (C).  Similar 
process to create an arc tangent.
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Chapter 5

principles of design & documentation

In the drafting and design field, a person will encounter many 
opportunities to design various components. This can range from 
designing hardware such as fasteners and clamps, designing 
fixtures and jigs to support the manufacture of an item, design 
product transportation systems like conveyer belts that use small 
pallets to deliver product to various manufacturing steps, to de-
signing tools used in a machine shop to fabricate complex shapes 
and features.

design process
The design process is an integration of sketching, creativity, anal-
ysis, and problem solving. With the use of CAD and the internet 
designers are better able to communicate their ideas and collabo-
rate with their customer to produce a product faster, cheaper, and 
better than ever before. The power of our emerging technology 
is also changing the way we do business. Once, one company 
would produce all their own parts to form an assembly. Now we 
see parts being produced globally, and assembled globally, to 
further advance our lives and our comfort at a decreasing cost. 
Combining the design process with the globalization environment 
introduces new considerations for engineering and production.

• Federal and state regulations
• Environmental impacts
• Demographics
• Consumer trends
• Cultural trends
• Economic value

These changes also influence a designer’s required knowledge 
base. Traditional training involved learning about such items as: 
design fundamentals, capabilities of tools and equipment, manu-
facturing processes, knowledge of materials, and general math. 
Today, a designer needs additional knowledge with the concepts 
of team functions, efficient manufacturing, data acquisition, 
packaging, safety and error-proofing, computer skills, and oral 
presentation skills.

The design process involves a sequence of stages including prob-
lem identification, forming preliminary ideas, conducting analysis, 
refinement, and implementation. stage one, problem identifica-
tion begins by identifying a need. What does the customer want? 
Where and how will this be used? Problem identification includes 
doing some research. Is a solution already available? Is it cost-
effective to design something new? Perhaps an existing item can 
be modified to meet that need without having to “re-invent the 
wheel”. The second stage of the design process is to gather some 
preliminary ideas. Start by generating several options in the form 
of sketches. It may be necessary to work with a team to brainstorm 
a variety of solutions depending on the complexity of the need. It 
is also beneficial to gather the ideas and opinions of your customer. 

The third stage of the design process involves analyzing your solu-
tion. This can be accomplished by creating a detailed design of the 
solution. One suggested analysis method includes creating a 3-D 
solid model of the solution which can have kinetics applied to its 
parts moving them through their range of motion to look for prob-
lems. Another method is to create a rapid prototype of the design 
from the 3-D solid model. This prototype could be made from liquid 
resin which is heated by a laser layer-by-layer to form a physical 
model of the design. This prototype is now a physical part that you 
can see, touch, and use in a design review with the customer. 

The fourth stage is refinement of the design. Does the design 
meet the customer’s need? This step includes re-evaluating the 
design if necessary to see if the design can be made more ef-
ficiently. Decisions are made to ensure the solution is designed 
for manufacturability. Does the design include parts off-the-shelf 
instead of machining new parts? It is less expensive to modify an 
existing item than it is to make a part completely from scratch. 

The final stage of the design process is implementation. This 
includes the drafters complete working drawings of the final de-
sign; getting the customer’s approval on the design; sending the 
working drawings out for manufacturing cost quotes; getting the 
parts manufactured per the design; writing a procedural manual 
(if necessary) explaining how to assemble, use, and maintain the 
parts; and documenting any design changes that may have oc-
curred during manufacture.
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Now that we have covered the design process, let’s move into the 
mechanics of documenting a design. There are five major areas 
that will be covered: sketching; formats and the title block; draw-
ing notes, drafting standards; and terminology and abbreviations.

Sketching
Sketches are an important communication tool. Sketching, or 
free-hand drawing with pencil and paper, is a way to visually 
express new ideas to solve design problems. Initial generation 
of ideas using a computer is uncommon because sketching can 
be done virtually anywhere: at your desk, in the lunch room, or 
during a conference meeting when a team is discussing ideas. 
Sketching also allows the drafter to generate many options very 
rapidly. These rough sketches are then refined by adding some 
basic dimensions and other information that will later be trans-
ferred into a computer aided design (CAD) drawing. 

Sketching before drawing is essential. It has been documented 
that drawing before making a list of sketched alternatives will 
result in poorly conceived products. The reason behind this is 
simply based on customer expectations. A CAD drawing implies 
a more advanced state of planning which will intimidate the 
customer from making suggestions for change. The customer will 
be afraid to make suggestions because it appears that the designer 
has already invested too much time in the analysis stage of the 
design process to make any changes. This can result in a substan-
dard design and poor product satisfaction during the implementa-
tion stage of design. Whereas, a sketch implies an early state of 
planning and design. This invites input and participation on the 
part of the customer. The resulting product is more likely to be 
appreciated and understood by the customer.

Sketching is a free-wheeling type of informal drawing that 
helps inspire the basic design of an object before advancing to 
the more exacting scaled drawings. The essence of sketching is 
simple: draw whatever pops into your mind, and revise as you go 
until you find a design you like best. With practice you will find 
sketching to be fun. Below are some sketches of a table that show 
the refinement steps used to achieve the final result.

 

Sketches can be done in a couple of formats. The orthographic 
method creates 2-D views of your concept. This is usually the 
simplest format to start with when learning to sketch. Draw a 
front view and any other views necessary to describe your idea. 
The sketch does not need to be drawn at any particular scale. 
However, with practice and experience you will find that drawing 
additional features to the correct proportion of your general out-
line will aid in visualizing the true concept. The second, and most 
widely used method, is the isometric method which allows you 
to visualize your idea from multiple sides with only one drawing. 
With this method, create a 3-D view of your idea. 

Which method you choose depends on your level of comfort 
and experience. It is more important to decide the method that 
best conveys your ideas in which you can present them to your 
customer as solutions to their needs.

 

Orthographic and Isometric Sketches

Sketching Exercise:

Using pencil and paper, sketch some possible solutions to the fol-
lowing customer’s request.

The customer would like a student designer to develop a device 
that will provide light as it is carried in one hand.
 
Requirements:
 1)  Small enough to carry in one hand
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 2)  Able to be carried for extended periods of 
  time and distance
 3) Simple to operate and affordable to purchase

Student Designer: Interpret what the customer has asked for 
along with the stated requirements. Develop two possible  
solutions by sketching ideas on one or more pieces of paper.  
Use either sketching method. Submit the two sketches to your 
instructor for review.

terminology and abbreviations
The following definitions represent the common terms and fea-
tures designers will encounter during design and product manu-
facturing. The list of abbreviations that follow are those used as 
standard short-cuts in spelling out a word or phrase. Since there 
is an overabundance of terms and abbreviations known to exist, 
those listed here are most likely to be used by apprentices.

Terminology:

Angular dimension
n Measured dimensions 
 represented by Degrees, 
 Minutes, and Seconds

Auxiliary view
n Orthographic view projected 
 off a plane showing true size and shape
n Shows features appearing on inclined surfaces
n Shows features appearing on oblique surfaces

Axis
n Central line about which parts are arranged
n Elements may or may not revolve around it

Baseline dimensioning
n System of dimensioning used to locate features of a part
n Uses a common set of datum’s

Basic dimension
n Exact value of a feature

n Describes the following: Size and Location

Bilateral
n “Bi” means two
n Indicates that two sides are used. (E.g.: bilateral tolerances)

Blind hole
n Hole that does not go through all of the material
n Common in thick parts

Burr
n Jagged edge of metal produced by working the metal
n Common note of drawing is to “REMOVE ALL BURRS”

CAD drawing
n Drawing created by computer-aided drafting methods
n Electronically stored, revised, and retrieved

CAM
n Computer Aided Manufacturing
n Software used to convert CAD drawings into 
 machine code for use in fabricating a part

Casting
n Metal object made by pouring molten metal into a mold. 
 The molded, or cast, part is usually made from iron or 
 aluminum

Chamfer
n Corner removed from end of cylindrical surface
n At an angle to face
n Used to facilitate assembly
Counterbore (v)
n Process to enlarge the end of a hole cylindrically
n Dimension specifications include diameter and depth of 
enlarged section

Countersink (w)
n Process to enlarge the end of a hole conically
n Dimension specifications include diameter 
 and included angle
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Datum
n A reference point used to establish location of other features
n A datum can be: A point, a line, a surface, or a plane

Degree
n Unit of angular measurement

Depth (x)
n Used to show the distance of a feature that does not 
 go through all of the material

Fastener
n Connector used to secure two or more parts together
n Examples: Bolts, Nuts, Screws, Rivets, etc.

Feature
n The term used to describe the form or shape of an 
 object that has been added to a basic shape
n Examples: A notch, a hole, a tapped hole, an angle, 
 a slot, etc.

Fillet
n Concave surface (interior radius)
n At intersection of two surfaces of an object

Fixture
n Device designed to position and hold a part in a machine tool
n Does not guide cutting tool 
n References part to tool

Isometric drawing
n Three-dimensional 
 pictorial drawing 
n Horizontal surfaces drawn 
 on 30° axes from horizontal

Jig
n Device used to hold a 
 part to be machined
n Positions cutting tool 

n Guides cutting tool

Orthographic projection
n Process of projecting 
 essential views of three-dimensional  
 object on a two-dimensional plane

Parallel
n Extending in the same direction (e.g.: two lines)
n Equidistant at any point
n  Lines do not meet

Perpendicular
n Projecting at a right angle (90°) to a given line or plane

Radius (R)
n Distance from center of circle, or an arc, to its circumference
n Equal to one half of a diameter
n Radii is the plural from of radius

Reference dimension
n Used only for information purposes
n Does not receive standard print tolerances
n Should not be used for production or inspection

Scale
n Refers to relative size of drawing and size of part
n First number represents size of drawing
n Second number represents size of part
n Examples: 2:1 means the part is being shown twice as large  
 as the full size part; 1:2 (half scale) means the part is being  
 shown at one half of its full size.
Section
n Interior view of an object
n Drawn to expose features not otherwise visible

Symmetrical 
n Same on each side
n Equal halves
n Centerline usually indicates symmetry

Tapped hole
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n A feature applied to a part that includes the 
 cutting (tapping) of threads

Tolerance
n Permissible variation from a given dimension
n Unilateral, bilateral

Abbreviations:

• ALUM = Aluminum
• BC or BS = Bolt Circle or Bolt Spacing 
 (Used interchangeably)
• CI = Cast Iron
• CRS = Cold Rolled Steel
• CBORE = Counterbore (obsolete)
• CSK = Countersink (obsolete)
• DIA = Diameter (obsolete)
• DP = Depth (obsolete)
• DR = Drill or Drill Rod
• ECN = Engineering Change Notice
• ECO = Engineering Change Order
• EQ = Equal or Equally 
• FAO = Finish All Over
• FIL = Fillet (may also be a Round) (obsolete)
• GA = Gage (for sheet metal)
• HRS = Hot Rolled Steel
• IAW = In Accordance With
• ID = Inside Diameter
• LH = Left Hand
• MATL = Material
• MAX = Maximum
• MIN = Minimum
• OD = Outside Diameter
• R = Radius
• REF = Reference (obsolete)
• SECT = Section
• SP = Spaced
• SST = Stainless Steel
• STK = Stock
• STL = Steel
• THD = Thread
• THK = Thick or Thickness

• TOL = Tolerance
• TYP = Typical

Terminology and Abbreviations Exercise:

QUIZ:

1. Give the term which means “Software used to convert 
 CAD drawings into machine code for use in fabricating 
 a part.”

2. Give the term which means “Central line about which 
 parts are arranged.”

3. Give the term which means “Connector used to secure 
 two or more parts together.”

4. Give the term which means “A feature applied to a part 
 that includes the cutting of threads.”

5. Write the abbreviation for the following items: Aluminum; 
 Material; Radius; Stainless Steel; and Typical

Formats and the Title Block
Drawings made for mechanical design are known as technical 
drawings. There are various elements of a technical drawing that 
have relative importance and relationship to each other. Every 
drawing should contain select information including the format 
size, the title of the part, the assigned part number, the relative 
scale of the drawing, the design and drafting approval data, the 
date in which the drawing was produced, and general notes. The 
method of presenting and locating this information on a draw-
ing varies from one industry to another, yet most methods derive 
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from the American National Standards Institute and the American 
Society of Mechanical Engineers (ANSI/AMSE Y14.1-1995 
DRAWING SHEET AND FORMAT STANDARDS)  
specification.

The format size and orientation chosen depends on the size and 
complexity of the object designed. This may further be influenced 
by the standards set forth by the customer, or your company. For 
instance, some companies prefer to use one dedicated format size 
for all drawings to keep them consistent from one design to the 
next.

There are ten format sizes available in which the last four special 
sizes are not often used. Of these ten sizes, the first four are the 
most commonly used formats (A– D).

 

• A – Size = 8-1/2 x 11 (landscape or portrait orientation)
• B – Size = 11 x 17 (landscape or portrait orientation)
• C – Size = 17 x 22 (landscape orientation)
• D – Size = 22 x 34 (landscape orientation)
• E – Size = 34 x 44 (landscape orientation)
• F through J are available although not commonly used.
 The components that make up the drawing format include:
• Drawing field
• Title block location and contents
• Revision block location
• Parts listing or the Bill of Materials (BOM)
• Zoning

Every drawing has a drawing field. This is the main body of the 
drawing and is used to draw the object and all necessary views. 
This area will also include the related dimensions and notes to 

complete the drawing. There is an imaginary border of approxi-
mately ½ inch (shown by the dashed lines) towards the inside 
to prevent the drawing information from overflowing past the 
bordered format.

 

Typical ANSI/AMSE Y14.1-1995 Drawing Format

 

Typical Drawing Title Block
1.  The Title Block - is located in the lower-right area of the 

drawing format and includes areas for specific information. 
Most companies use preprinted sheets with the company’s 
name, address, logo and borders as well as other pertinent 
information related to its particular business. Title block 
sizes and the type of information required will vary depend-
ing on the size of the company and the types of products it 
manufactures. Some companies require basic information in 
the block, while others, especially those under government 
contract, need to provide more data. 

2.  CONTRACT NO. block - The contract number is entered 
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here only when appropriate or required.

3.  DRAWN BY block - The drafter’s name appears here in 
printed form. In addition, the day, month and year the draw-
ing was completed is usually shown.

4.  CHECKED BY block - This is the name (usually a signa-
ture) of the person who is assigned to check the drawing for 
accuracy and completeness.

5.  DESIGN block - This is the name (usually a signature) of 
the responsible engineer.

6.  DESIGN ACTIVITY block - This is the name (usually a 
signature) of the program manager or chief engineer.

7.  Company Name and Address block - This block is for the 
company name, address, and trademark or logo.

8.  Format Size block  - This block contains a letter indicating 
the appropriate size of the drawing format.

9.  TITLE block - This is where the drawing’s name or title for 
the part or assembly is placed.

10. DRAWING (DWG) NO. block - The drawing’s number is 
inserted here. Every company has some form of part-num-
bering system.

11.  RELEASE DATE block - This block is for the date that the 
drawing is released for manufacturing. It does not change 
when the drawing is revised. It reflects the original informa-
tion.

12.  SHEET block - This block contains the number of sheets in 
a drawing set. (E.g.: 1 of 1; 1 of 2; 2 of 2; etc.)

13.  SCALE block - This block indicates the scale of the part in 
the drawing. (E.g.: 1:1, FULL, 2:1, 4:1, 1:2; etc.)

14.  Standard Drawing Tolerance block - This gives the  

drawing’s default tolerances for dimensions unless  
otherwise specified.

 **As a side note**: This information is usually established 
by the company based on their requirements or industries 
standards. This information is not usually changed from 
drawing to drawing, hence the title Standard, and instead  
any global tolerance changes should be noted in the  
general notes.

15. FINISH block - This block specifies the type of surface coat-
ing or process to be applied.

16. TREATMENT block  - This block notes the type of material 
treatment to be applied. (E.g.: Heat Treat, Rockwell hard-
ness, temper, etc.)

 

Typical Drawing Revision Block

17. Revision area - Most drawings require one or more revisions 
during their lifetime. Revisions can be in the form of a slight 
change in shape, dimensions, text, etc. due to changes in de-
sign, changes in a customer’s requirements, or to correct er-
rors in design or drafting. To perform an engineering change 
to a drawing, an authorized person must write a formal 
document stating all the things that are to be changed. This 
document is an engineering Change notice  (or eCn) or 
engineering Change order (eCo). To record engineering 
changes on drawings, a revision block, is established. Ac-
cording to ANSI specification, the revision block is located 
in the upper-right corner of the drawing and provides space 
for a zone location, revision letter, description of the change, 
date, and approval for the change. The ECN/ECO number is 
usually also noted.
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Typical Drawing Parts List Location

 18. Parts List  - The parts list is located in the lower-right corner 
of the drawing, directly above the title block. The list indi-
cates the items, materials, and quantities required to complete 
the part or assembly. It is referred to as the Bill of Materials 
(BOM). The parts are normally arranged with “Make” items 
listed first followed by “Buy” (or purchased) items. Items are 
usually listed in an ascending numerical order.

 

Typical Drawing Parts Identification Location (BOM)
19.  Parts Identification - An item number is required for each part 

shown on an assembly. This ties the item to the parts list (18). 
The method for keying the two is through the use of balloon 
numbers, which consist of identification numbers placed inside 
circles called Item Balloons. Each item balloon is attached to a 
Leader. The leader is a thin line that ends in an arrowhead that 
points to and touches the related part in the drawing field. The 
leader is almost never shown as either a horizontal or a vertical 
line (always at an angle) to avoid confusion with other lines on 
the drawing. The item balloon should be placed horizontally or 
vertically aligned, and in numerical sequence when possible. 
Item balloons are usually .625 inch (5/8”) in diameter with .50 

inch (1/2”) text, however they can vary in size from .31 (5/16”) 
to .75 inch (3/4”) in diameter, depending on the size and scale 
of the assembly drawing.

 

Typical General Notes Location

20.  General Notes - Usually located in the upper left corner of 
the drawing field, or occasionally in the lower left corner 
depending on the company standards. These are used to 
indicate general manufacturing information. See the next 
subsection for more detail.

 

Drawing Zones
Drawing Zones - The drawing field is divided into zones. These 
zones are marked by letters along the sides and numbers along 
the top and bottom. Zones are used to identify the location an 
item on a drawing and are usually specified in the Letter-Number 
call out. Zones can be used to identify the location of a drawing 
change, a displaced detail or section drawing, or to locate item 
balloons for parts listed in the BOM.
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Formats and the Title Block Exercise:

QuiZ:

1. List the five components of a drawing format.

2. Identify the four most commonly used formats 
 and their related sizes.

3. The Drawing Field is divided into sections called: 
_______________________________

4. Where are the General Notes usually located in a 
 drawing field?

5. Identify the four most commonly used formats and their 
related sizes.

drawing notes
Drawings include a variety of notes and information for the 
customer and fabricator to interpret and use. This subsection will 
cover the location and precedence of these notes.

 

Title Block Notes
There are three main types of notes used on a drawing, listed in 
their order of importance, which are the Title Block notes, Gen-
eral notes, and the Part Detail notes. As mentioned in the above 
section, the Title Block contains an area where Standard Toler-
ances are noted and apply to the entire drawing unless otherwise 
specified. This area also contains additional information that 
applies to the entire drawing. That is, unless the General notes for 
the drawing have information that contradicts this information.

 

General Notes

General notes supersede the information in the Title Block (that’s 
why the UNLESS OTHERWISE SPECIFIED is noted in the 
block). General notes also carry the “UNLESS OTHERWISED 
SPECIFIED” note and since they apply to the whole drawing, 
they can only be superseded by the Part Detail note.

 

Part Detail Notes

Part Detail notes have the highest priority in the chain of notes. 
A part detail note is used to describe a specific function that only 
applies to the highlighted feature of a part. This can by anything 
from a change in dimensional tolerance for a feature, a note about 
a change in surface roughness, or a note about a surface treatment.
In summary, the precedence of drawing notes allows for informa-
tion stated on a drawing to be superseded by virtue of where the 
information is noted.
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Drawing Notes Exercise:
QuiZ:

1. Name the three types of notes used in their order of  
priority from lowest to highest.

2. Which type of note has the highest priority on a drawing?

3. Which type of note has the Standard Tolerances located 
within it?

4. Explain what “UNLESS OTHERWISED SPECIFIED” 
means.

5. List the three types of notes in their order of priority  
from lowest to highest.

drafting standards
Drafting standards are the “nuts & bolts” of making a good draw-
ing. These include: 

• Layer settings: Using good layering practices will making 
reading and plotting your drawing much easier.

• Line type settings: Following the “alphabet of lines” helps 
avoid confusion between elements of the drawing.

• Scaling and Scale Factors: This means drawing at full scale 
in model space and selecting the proper scale factor to apply 
to your paper space viewport.

• Text Styles and Dimensioning Element standards: Setting 
up and using industry approved text styles and dimensioning 
standards for your drawing.

layer settings
After opening a blank drawing session go to the Explore Layers 
icon to create the layers necessary for a technical drawing. The 
layer names listed here are just a few that can be added to be used 
in a drawing. The recommended layers are:

• 1 through 5 for Object Lines
• C or Center for Center Lines
• Cutting Plane
• D or Dimension for Dimension Lines
• H or Hidden for Hidden Lines
• P or Phantom for Phantom Lines
• VP or View Port
• X or Hatching for Cross-Hatch Lines

There are a few additional layers that are often used in a draw-
ing. They are F or Format to place your first sheet format on, F2 
to place your second sheet format on (in a multi-sheet assembly 
drawing), and N or Notes to place any set-up notes or miscella-
neous information that you don’t want plotted on your drawing. 
Next, assign colors to the layers. Color is used to easily distin-
guish the different layers based on their color and not their line 
type. Color selection can be a personal choice or can be mandated 
by the company or customer.

line type settings
There are several line types used in drafting to describe a draw-
ing. Each line type has a different thickness, or line weight, to 
help identify the different lines used in a drawing. This is referred 
to as the Alphabet of Lines. ANSI/ASME Y14.2-1992 LINE 



57

fundamentals of draftting

CONVENTIONS AND LETTERING STANDARDS sets these 
requirements. 

The Alphabet of Lines are to drafting what the alphabet is the 
English. In order for the drafter to communicate, the names and 
usage of each line type must be understood. The most common 
line type is the one showing the outline of the object. This is 
known as the object or visible line. Visible lines are drawn at a 
standard recommended 0.6 mm thick line weight. The line weight 
for thin lines is 0.3 mm. See below for a description of each line 
type, their appropriate line weight, and their common usage. 
 
 

Line Types used in a Technical Drawing

Visible line (Object line - #1)
• Represents visible edges
• Represents outline of the object being drawn

Hidden line (#2)
• Represents edges or outlines not visible in given view
• Represented by a series of short dashed lines

Section lines (Hatching - #3)
• Appear only on a sectional view
• Appears where surface has been cut
• Normally drawn diagonally

Centerline (#4)
• Indicates symmetry, center points, or axes
• Consists of alternating long and short dashes

Dimension line (#5)
• Denotes the extent of the dimension
• Use with arrowheads

Extension line (#6)
• Extends surface or point away from view
• Used for the purpose of dimensioning

Leader (#7)
• Drawn diagonally
• Directs a dimension or note to an area
• Normally terminates with an arrow
• May terminate with a dot
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Cutting-plane line (#8 or #9)
• Shows where imaginary cutting takes place to  

create a sectional view
• May be a series of two short dashes between single  

long dashes or alternately a series of long dashes
• Arrowheads indicate the direction of sight

Viewing-plane line (#8 or #9)
• Used in conjunction with removed views to show  

where view would normally appear
• Arrowheads indicate direction of sight

Short break line (#10)
• Terminates a view to conserve space and avoid congestion
• Separates internal and external features with 
 broken-out sections

Long break line (#11)
• Allows removal of a long central portion of an 
 object to shorten a view
• Normally used in pairs

Phantom line (#12)
• Replaces repetitive detail - e.g.-coils, gear teeth, threads, etc. 
• Drawn with two short dashes between single long dashes
• Lines are thinner than the cutting/viewing-plane line
• Represents the outline of an adjacent part
• Shows alternate position of a given part

 

                               Alphabet of Lines

It is not uncommon for line types to coincide or overlap in a 
drawing. When visible lines, hidden lines, or centerlines coincide 
in the same view, a preferred line is illustrated. That chosen line 
is determined by what is called the Precedence of Lines. This 
is the hierarchy of line importance when lines overlap. This list 
ranks the line type precedence from highest to lowest:

• Object or visible line 
• Hidden line
• Cutting plane line
• Center line
• Break line
• Dimension and extension lines
• Sectioning lines
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In the example you can see where lines coincide with one another 
from the front view to the side view. The “X” lines are object 
lines which overlap the hidden line of the circles (holes). The 
“Y” line is also an object line which overlaps the center line of 
the large circle. The “Z” line is a hidden line. Although the center 
line for the small circle (hole) is in front of the hidden line, the 
hidden line has precedence over the center line and is therefore 
shown instead of the center line.

scaling and scale factors
To simplify applying scale factors, remember that CAD drawing 
environments include both model space and paper space. Use 
model space to draw your object at full scale (1:1). Use paper 
space to scale the drawing to fit within the drawing field (called a 
viewport in CAD) for the chosen format size.

 After you have drawn your object full 
size in model space, you will have to decide which drawing for-
mat size to use. The size you use is dependent on the number of 
views and the level of detail you want to show. Once the format 
size is selected, you will enlarge or reduce the object size while in 
paper space to fit within the drawing field. This setting becomes 
the scale of the drawing (called viewport scale in CAD) and is 
used for scaling text, line types, and dimensions.

Viewport Scale Text Height Scale
1:1 1:1
2:1 1:2 (.50)
4:1 1:4 (.25)
10:1 1:10 (.10)
1:2 2:1 (2.0)

1:4 4:1 (4.0)
1:10 10:1 (10.0)
 
Text height scaling is the inverse of the viewport scale selected 
for a drawing. For example: if your viewport scale is 1:1 then 
your text height scale will be 1:1. However, if your viewport 
scale is 2:1 then your text height scale will be 1:2 or half as large. 
See the accompanying table for some common scale factors.

 

Text Styles and Dimensioning Element Standards
These settings include 1) text height, 2) text style, 3) dimension 
settings, and 4) dimensioning symbols; and are necessary for 
effectively describing the basic elements used when detailing a 
drawing. The industry standard for mechanical / technical draw-
ings is to use the following values when setting up your drawing. 
These values may vary from the ANSI/ASME Y14.5-M-1994 
standard or from one company to the next. 

1)  Text height. These standards are at full scale (1:1). For that 
reason, if the viewport scale is not 1:1, adjust the text height 
according to the table above.

 
General Note heading text height:
• ¼” or .25; modified to 5/32” or .156 (rounded to .16)  

for A-Size drawings
 Example: notes (unless otherWise speCi-

fied):

Body of General Note’s text height:
• 3/16” or .188 (rounded to .19); modified to 1/8” or  

(.125) for A-Size drawings
 Example: 1. BREAK ALL SHARP CORNERS  

AND EDGES

General text height:
• 1/8” or .125; no modification for A-Size drawings
 Example: All dimensions, part notes, etc.)

2)  Text Style. The CAD software default text style is called 
Standard, also known as Monotxt, and is acceptable although 
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very “boxy.” Some common alternate styles are RomanS 
and Simplex. To change the text style, type “style” at the 
command prompt for the Text Style dialog box to appear. 
Click on New and type RomanS in the accompanying dialog 
box. Next, select the black arrow in the Text Font field next 
to Name and scroll down to find the RomanS font. Select 
this font and your Text Style dialog box should look like the 
example shown. Repeat this procedure to add the Simplex 
style.

 

3)  Dimension settings. The components that make up the basic 
dimensioning elements include:

• Dimension Format
• Arrowhead size
• Extension Line placement
• Text format and height
• Units
• Tolerances / Zero suppression
• Scale Factor

These components are set up by the drafter using the CAD soft-
ware dimensioning style settings dialog box. Here are some of the 
more common values for each of these elements:

• Dimension Format:
 o Fit Method: Best Fit (whenever possible)
 o Text Placement: Beside the dimension line
 o Distance around dimension text: .090
• Arrowhead size: 1/8” or .125

• Extension Line placement:
 o Offset from Baseline: .380
 o Offset from Origin: .0625 (also known as Extension 

Line Offset)
 o Extend lines past: .125 (also known as Extension 
  Line extension)
• Text Format:
 o Text style: Standard, RomanS, or Simplex
 o Text height: 1/8” or .125
• Units:
 o Unit type: Linear
 o Decimal places: 3
 o Suppress leading zeros: On
 o Suppress trailing zeros: Off
• Tolerances:
 o Decimal places: 3
 o Suppress leading zeros: On
 o Suppress trailing zeros: Off
• Scale Factor:
 o This value is dependent on the Viewport Scale.

Look on the next page for screen-shots of the above elements:
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Arrowheads:
  

Dimension Format:

Lines:
  

Text:
 

Tolerances:
  

Units:
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4)  Dimensioning Symbols. Dimensioning symbols are used 
as a prefix or suffix to a given dimension. These symbols, 
adopted in the ANSI/ASME Y14.5-1994 standards, are used 
to replace obsolete abbreviations. Below you will see the 
symbol and its representation (the obsolete abbreviations are 
in parentheses).

• ° = Degrees
• ± = C
• Ø = Diameter (DIA)
• v = Counterbore (CBORE)
• w = Countersink (CSINK)
• x = Depth (DP)

To apply these symbols to a displayed dimension you will need 
to highlight the desired dimension, right-click the mouse button 
to display a new dialog box from which you should select the 
Properties option. This will open the Properties dialog box. The 
first three noted symbols (degrees, plus/minus, and diameter) are 
the easiest to apply to the dimension. They are achieved by typ-
ing the percent symbol on your keyboard twice followed by the 
appropriate letter:

• %%d = Degrees
• %%p = Plus/Minus
• %%c = Diameter

There are two methods that you can use to append these symbols 
either before or after the dimension. The first method is to simply 
click in the “Override text” field ahead of the <> marks. As an 
example, let’s apply the diameter (Ø) symbol as a prefix and 
the plus/minus (±) symbol with a value of .003 to the selected 
dimension text. The entry in the “Override Text” row would 
be: %%c<>%%p.003 (notice there is no space after the > and 
before the %). This will display the new dimension value as: Ø 
4.130±.003. The other method is more time consuming although 
more technically correct. This involves the same procedure to get 
to the Entity Properties dialog box; however, instead of just over-
riding the text, you will select the Dimension Settings button. 

This will open a new dialog box titled Dimension Settings. Select 
the Text tab and enter the appropriate values in the Prefix and 
Suffix boxes. Press enter or select OK and your dimension text 
will yield the same result.. The last three symbols (counterbore, 
countersink, and depth) are created using a new text style called 
GDT. It’s best to load this style first before making changes to 
your dimensions. You can add this text style by selecting the 
Explore Layers icon and selecting Text Styles under the Element 
column. Select the New Item icon and type GDT. Next, highlight 
the Font Name, defaulted as “txt.shx” and select “gdt” from the 
pull-down list or type the name in the box. Once you have this 
accomplished you can proceed with editing your dimension text.
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To form these three GDT symbols use the following values:

v = Lowercase v
w = Lowercase w
x = Lowercase x

NOTE: It is very important to use the lowercase letters otherwise 
the symbols will not appear.
To edit the dimension text using these symbols, use the same 
steps outlined above for the technically correct method (select 
Dimension Setting button) and enter the appropriate letter in the 
Prefix and/or Suffix box. You can also add additional informa-
tion or mix values to achieve the desired results. For example, 
prefix: w%%c Suffix: %%p x.500 would yield the following: w 
Ø4.130±.003 x.500. Here are some additional examples:

• v Ø.500 x.188
 o Meaning: Counterbore a .500 diameter hole  

to a depth of .188

• w Ø.375 X 82°
 o Meaning: Apply a countersink, with an included  

angle of 82°, to a major diameter of .375

• 1.2508±.0005
 o Meaning: Apply a tolerance of plus .0005, and  

minus .0005 to the dimension

Drafting Standards Exercise:

QuiZ:

1. Drafting standards are considered the
 “__________________” of making a good drawing.

2. What is the term used to describe the collection of 
 line types used in drafting?

3. Of the many line types which is the most common?

4. If an Object Line and a Center Line coincide in 
 the same view which line type should be shown?

5. If your Viewport Scale is 4:1 (four times larger than full 
 size), what scale would be applied to the Text Height to 
 achieve the desired text height on the plotted drawing?

6. What is the publication that sets Line Conventions 
 and Lettering Standards?

7. What is the industry standard text height for general text?

8. Dimensioning symbols can be appended as a __________ or 
 __________ to a given dimension.

9. What is the “override text” you would enter to display the 
 Degrees, Plus/Minus, and Diameter symbols?

10. What text style is used to create the counterbore, 
 countersink, and depth symbols?
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Chapter 6

principles of projection

Orthographic projection is the process of describing essential 
views of three-dimensional objects onto a two-dimensional plane. 
This section will demonstrate how to draw the necessary views 
that correctly identify all pertinent details of a part. There are 
times when one view will adequately describe a part; and there 
will be other times when five, six, or even seven views will be 
necessary to describe all the features of a particular part. The sim-
plicity or complexity of the design will determine the number of 
necessary views and whether or not auxiliary and sectional views 
are required. 

types of planar geometric projections

Perspective  Parallel  

One-Point   

Two-Point Oblique       Orthogonal 

Three-Point    

 Cavalier  Multiview  Axonometric

 Cabinet     

   Third Views  Isometric

   Auxiliary Views  Dimetric

   Sectional Views  Trimetric

planar geometric projections
Planar geometric projections are a specific category of projec-
tions which maintain straight lines when mapping an image 
onto a viewing surface. The category differs from non-planar 
projections in the type of viewing surface and projectors used 
for displaying a three-dimensional object. In a planar geometric 
projection, straight lines form the projectors map the objects im-
age to a planar viewing surface called the view plane. In contrast, 
a non-planar projection uses curved projectors to map an image 
onto a curved surface. 

We will first begin discussion of parallel projection, one of two 
classes of planar geographic projection.  With parallel projec-
tion the placement of the center of projection is at infinity, which 
means that edges parallel on the real object are also parallel in 
the projection. This allows for the least amount of distortion of 
features within the object.  There are two different types of paral-
lel projection, oblique and orthogonal which will be discussed 
below.  

orthographic projection
The predominant method of producing technical drawings is 
through the principles of orthographic projection. The term 
orthographic is a contraction of two Greek words - orthos, which 
means “straight, correct, at right angles to,” and graphikos, which 
means “to write or to describe by drawing lines.” In orthographic 
projection, different views of an object are arranged on a drawing 
to convey information. Features, surfaces, lines, and edges are 
projected at straight or right angles from one view to another. The 
orthographic drawing is used to provide accurate measurements 
and details to produce the object. It is not used as a realistic view 
of the object. An isometric projection provides that visual three-
dimensional representation of the object.  

There are six principle views that can be used to describe an 
object. These are described as the Front, Top, Right Side, Left 
Side, Rear (or Back), and Bottom views. (There are other views 
that can be incorporated into a drawing, such as auxiliary views 
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and section views; however those will be discussed later.) These 
principle views show an objects true shape and size. You should 
use the minimum number of views that are necessary to properly 
dimension and describe your object. In other words, views shown 
on a drawing should add some value to your drawing and should 
have one or more dimensions associated with them. An object 
that is cylindrical or symmetrical about an axis needs at least two 
orthographic views drawn to completely describe it. Objects with 
more complex shapes need three or more views drawn.

There are two types of orthographic projection used in industry: 
third-angle projection and first-angle projection. 

The first, third-angle projection, is used primarily in the United 
States and Canada. This projection type is sometimes described 
as “unfolding the box.” To understand this concept, visualize 
the transparent box illustrated below with the object to be drawn 
placed inside the box so that its axes are parallel to the axes of  
the box. The projections on the sides of the box are the views  
one sees by looking straight at the object through each side.

If each view is drawn as seen on the side of the box and the box 
is unfolded and laid flat, as shown below, the result is a six-view 
orthographic projection of the object. Any view of the object 
could be regarded as the principle view, and the box could be 
folded out from any view. The box shown at the right is unfolded 
from the front view, which is the most common practice.

Figure 6-1

The second type, first-angle projection, is used by multi-nation-
al companies (those doing business in both the United States and 
abroad) and is the preferred method in most European and East-
ern countries. Although the two projection methods may look the 
same at first glance, there are some subtle differences in how the 
same six views are projected to create the proper placement of the 
views. The process for projecting the views in this system is to 
envision your object in the same six-sided box although instead 
of “pulling” the Top view to the top surface of the transparent 
box we “push” it down to the bottom surface of the box. This is 
repeated with the other views as well. Look at Figure 6-2 and you 
will see the subtle differences in the views. The Top view in the 
Third-angle system becomes the Bottom view in the First-angle 
system as does the Left become the Right. The naming conven-
tion for the six principle views remains the same; it is their loca-
tion, or placement, that changes.
 

Figure: 6-2
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To denote which projection system is used for a drawing, a pro-
jection symbol is typically located in the Title Block region of the 
drawing format. The symbols used are reflected in Figure 6-3.

    
 

Figure 6-3

Orthographic Projections Exercise:

QUIZ:

1. List the six Principle Views.

2. Name the two projection systems.

3. Which projection system is described as  
“unfolding the box”?

4. Which projection system is used by multi-national  
companies?

5. Draw (or sketch) and label the principle views used  
in the projection system that is primarily used in the  
United States and Canada.

single and multiview drawings
When deciding which views should be included on a drawing, 
keep this basic question in mind: “Can the part be easily manu-
factured without confusion from the drawing?” Select the least 
number of views that correctly detail the part. 

The first type of drawing we will cover is the Single-View draw-
ing. As the name implies, the drawing will contain only one view 
yet convey all the necessary dimensions to manufacture the item. 
This is used when the object is flat and has no other features on 
its sides that need to be dimensioned. Look at Figure 6-4 for an 
example of a thin Gasket that can be detailed as a single view 
drawing.

 

Figure 6-4

The thickness of the Gasket is given in the drawing as a general 
note: in this case, a .06 thick gasket stock. This general note pre-
cludes having to show a side view for that information. Cylindri-
cal objects such as a shaft can also be detailed in a single-view 
when there are no other features except its length and diameter 
that need to be expressed.

When a single-view is not enough to detail an object, then the 
next selection could be a Two-View drawing. Select this type 
of drawing when two adjacent views will provide the necessary 
information to detail the part. Adding a third view would be an 
unnecessary duplication of information. Objects circular about 
an axis of symmetry are best described with two-view drawings. 
Figure 6-5 shows an example of two adjacent views that will 
adequately describe a hub when the dimensions are applied.
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Figure 6-5

Sometimes a part is more complicated than the two shown above 
and it will require three or more views to properly describe and 
dimension the design features. This is when a three (or more) 
view drawing is necessary. With this type of drawing, the selec-
tion of the front principle view will determine the layout of the 
remaining views. When selecting the front view, consider the 
amount of detail provided on that view. Usually this view offers 
the most information that can be dimensioned in true shape and 
size. Here are some other guidelines for selecting the proper 
views:

n Select the view that will show the most detail  
as your front VieW.

n When selecting from these similar views, choose  
the one with the fewest hidden lines.

n Use a right or left VieW to show the profile features.

n Select the top or Bottom VieW to show  
additional features.

n Use additional VieWs as necessary to avoid  
dimensioning to hidden features.

Generally, the three adjacent views are comprised of the Front, 
Top, & Right. More views are used to capture hidden features and 
make them visible for the application of dimensions.
 

special drawings
Special Drawings are defined as those that require views other 
than the six principle views. When an object has features that can 
not be shown in their true shape and size with one or more of the 
six principle views, or if there are features which are buried inside 
an object that can not be dimensioned without dimensioning to 
hidden features or causing excessive clutter, then special views 
such as auxiliary, section, and detail views are added to a drawing. 

Auxiliary Views
The purpose of an auxiliary view is to clearly show the true shape 
and true size of an object that has an inclined surface. The auxil-
iary view is drawn as if it were hinged to the surface to which it 
is perpendicular and rotated up 90 degrees. 
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There are three basic types of auxiliary views—the primary, 
secondary, and partial auxiliary views. Each view has a particular 
function when it comes to detailing a part on a drawing. The pri-
mary auxiliary view is taken directly from any of the six principle 
views and there can be more than one primary auxiliary view as-
sociated with a part as long as it comes from a different principle 
view of the part. See Figure 6-6.

 

Figure 6-6

The secondary auxiliary view is a supplementary view taken 
directly from the primary auxiliary view when more detail is 
necessary to project the true shape and size of a complex inclined 
surface. See Figure 6-7.

 

Figure 6-7

The last of the three basic auxiliary views is the partial auxiliary 
view. This view is characterized as a supplementary view that is 
used to avoid crowding of views. Break lines are used to reduce 
the size of a view to control crowding. See Figure 6-8 for an ex-
ample of a partial auxiliary view. Without the use of break lines, 
this drawing would need to be drawn much larger in order to be 
adequately dimensioned.
 
 

Figure 6-8

sectional Views
The primary purpose of a sectional view in a drawing is to show 
the internal form and detail of a feature when it has an internal 
shape that cannot be accurately conveyed in one of the principle 
views. The sectional view represents a cutaway of an area that is 
used to apply detailed information about a feature. This cutaway 
usually eliminates the need for hidden lines, and shows the im-
portant outlines of the feature for the application of dimensions.

A sectional view is obtained by passing an imaginary cutting 
plane through an object and presenting the object as though the 
area cut off by this plane is removed. See Figure 6-9. There are 
several common types of sectional views: Broken or Partial,  
Full, Half, Offset, Removed, and Revolved. For the sake of 
simplicity, we will only cover the use of the broken, full, and 
removed views.
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Figure 6-9

A broken sectional view is characterized by a partial area be-
ing highlighted with a Break Line across, or around, the area to 
be sectioned and detailed. See Figure 6-10. With the area to be 
detailed defined, the once hidden lines become object lines and a 
hatch pattern can be applied.  The hatch pattern indicates the part 
of the object that has been sectioned.

 

Figure 6-10

This particular view type is probably the most commonly used 
sectional view. It is very easy to place, doesn’t require a separate 
view location, and adds clarity to a drawing to avoid mistakes 
when manufacturing the part.

The full sectional view is defined by a cutting plane line that 
passes through an object and exposes the full side of that object. 
The cutting plane line is drawn and labeled in an adjacent view 
from the section view. A label is used to define the sectional view, 
in the event that one or more sectional views exist for one part, 
and usually starts with the letter “A”. The labels are placed near 
the ends of the section arrows. The full sectional view is then 

labeled with the corresponding letter, such as SECTION A-A or 
SECT A-A. See Figure 6-11

 

Figure 6-11

The last sectional view type is the removed section. This is 
similar to a full sectional view except that the section is moved to 
a location that is not adjacent to the view containing the cutting 
plane. A removed section can be placed anywhere on a drawing 
and does not have to remain at the same scale as the view with 
the cutting plane line. This allows for greater detailing of the 
section when necessary and allows the removed sectional view 
to be placed in an uncluttered location. The removed section is 
labeled like the regular full section; and if the scale of the view is 
different than the scale of the original view, the new scale must 
be noted. See Figure 6-12, and SECT A-A in Figure 6-13.

 

Figure 6-12
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Figure 6-13

Applying sections with a CAD program requires simple knowl-
edge of using the program’s hatch command. This can also be 
referred to as cross-hatching or a boundary hatch. In your CAD 
program, create sections using a boundary hatch and the icon 
looks like this: 

There are several different styles of hatch patterns to choose from 
as shown by Figure 6-14 below. While there are an overwhelming 
number of patterns to choose from, the most commonly used pat-
tern is the ANSI 31, which is shown in Figure 6-14(a). This is the 
general pattern represented in most sectional views.
 

Figure 6-14

When creating a sectional view of a single object it is customary 
to have all the section lines going in the same direction. However, 
when creating a sectional view of a multi-part assembly it is cus-
tomary to switch the orientation of the lines to avoid confusion of 
where one part ends and the next part begins. To make changes to 
a hatch pattern, open the Boundary Hatch dialog box and select 
Pattern Properties. Modify the Scale to affect the spacing of the 
lines within the boundary of the section. Adjust the Angle to 
change the orientation of the hatch pattern and thereby changing 
the appearance within the section. Depending on the size of the 
area in which you are applying a hatch pattern, it may be neces-
sary to change the Scale value from the default of 1 to another 
value to achieve the desired effect. The scale is somewhat of a 
personal choice and depends on the amount of detail that you are 
trying to emphasize. For instance, a low scale value of .25 will 
bunch lines together and will be as distracting as having a high 
scale value of 10 thus having too few lines to properly highlight 
the view.

detail Views
When a view is cluttered with a lot of lines and part details it is 
sometimes preferable to add a special view that can be relocated 
and scaled up to provide the necessary dimensional information. 
Detail views are used for such a purpose. Use detail views when 
a feature is too small to be properly detailed or dimensioned at 
the drawing’s current scale. Detail views are generally twice the 
size / scale as the view from which it is taken although they can 
be scaled to any size that will define the area for proper dimen-
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sioning. For example, if the current scale is 1:1, the scale for the 
detail view may be 2:1 or larger. See Figure 4c-8 and note the 
label and scale for VIEW B. Like the removed sectional view, de-
tail views are labeled with a letter and their scale. It is customary 
to label the view with a consecutive letter following a sectional 
view label. The boundary for a detail view is highlighted using a 
cutting plane line type in the form of a circle or ellipse near the 
area that the view is extracted. It is also labeled with one of two 
methods: with a leader line note and a description, “SEE VIEW 
B”; or with the letter of the view placed near the boundary and 
arrows added as depicted in Figure 4c-8.

Axonometric Projections
Axonometric projection is another type of orthographic projec-
tion that shows parallel projection. Axonometric projection is 
used to create a view showing all three dimensions of an object 
in one single picture. Axonometric projection is a pictorial form 
of orthographic projection. Pictorials illustrate the object viewed 
from a skew direction in order to reveal all three directions (axes) 
of space in one image. An axonometric pictorial drawing of an 
object is created by rotating the object on an axis relative to a 
projection. Axonometric drawings often appear distorted because 
they ignore the foreshortening effects of perspective. Foreshort-
ening refers to the way objects appear to get smaller in both 
height and depth as they withdraw into the distance. There are 
three types of Axonometric projections: isometric, dimetric, and 
trimetric and they are classified by the angles between their axis 
lines. Axonometric projection is used for patent office records, 
furniture details, and structural designs. It is good for showing 
the 3-D nature of the object; however its lack of foreshortening 
creates a distorted appearance.

• isometric projection is the most frequently used type of 
axonometric projection. All three axis lines are at 120 degree 
angles which means the object’s dimensions are kept in 
proportion. These drawings show all three views: top, front, 
and side. This view is particularly useful for displaying and 
communicating conceptual design features. The isometric 
cube is angled so that all of its surfaces have the same angle 
as the plane of projection. As a result, the length of each of 
the edges shown in the projection is somewhat shorter than 
the actual length of the edge on the object itself.

 

                             Isometric Figure

• dimetric projection also shows all three views; however, 
two of the three axis lines are at equal angles with the 
plane of projection. The third axis line is therefore larger or 
smaller than the other two. The dimetric pictorials direction 
of viewing is such that two of the three faces appear equally 
foreshortened. The angles of the two equal front faces are 
determined by the direction of the view. 

  

                             Dimetric Figure
• Trimetric projection is a drawing where none of the angles of 

the axis lines are equal or kept in proportion. Trimetric pro-
jections are considered more realistic than isometric projec-
tions since most things we see are in a trimetric view. Since 
there are no restrictions on the orientation of the views, you 
can adjust the object to emphasize one or two dimensions 
over the others. 
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                         Trimetric Figure

oblique drawings
An oblique is the other type of parallel projection. The purpose 
of an oblique drawing is to show the true size of the front view 
while showing all three views of an object. In an oblique projec-
tion, the receding surfaces are drawn on an angle to give it a pic-
torial appearance. Oblique views are useful since they combine 
the advantages of both multiview and axonometric projections. 
One face (the front face) of the object is drawn without distor-
tion. The remaining two views show some of the object’s 3-D 
appearance. Because of its simplicity, oblique projection is used 
exclusively for pictorial purposes rather than as formal, working 
drawings. There are two types of oblique drawings, the cavalier 
and cabinet.

• Cavalier drawings are those in which all lines are made at 
their true length including the receding lines to maintain the 
true measurement of the object. They are drawn with the 
front face parallel to the picture plane and the receding lines 
drawn at 30, 45, or 60 degree angles. 

  

                     Cavalier Figure

• Cabinet drawings have the receding lines shortened by one-
half their true length.  This helps compensate for distortion 
and to approximate more closely what the human eye would 
see. Cabinet drawings are the most used form of oblique 
drawings because it reduces the distortion of the appearance. 

 

                              Cabinet Figure

perspective projection
The second type of planar geometric projection is perspective pro-
jection. A perspective drawing approximates how a person would 
view an object with their own eyes. For example, if a drafter was 
portraying a hallway of a building with a perspective view, the 
drawing would have lines receding to a vanishing point. In other 
words, objects appear to get smaller and closer together demon-
strating the illusion of depth. Perspective drawings are used for 
advertising and presentations of architectural, industrial, and engi-
neering design. These views are also good for providing a realistic 
3-D form of an object. There are three types of perspective views: 
one-point, two-point, and three-point perspectives.
• one-point views direct all of the lines to one vanishing 

point. One-point perspective would be like looking down a 
long straight road and seeing the road vanish in the distance. 

 

                               One Point Perspective
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• two-point views direct all lines to two different vanish-
ing points in opposite directions. A two-point view can be 
described as a person viewing a corner of a building while be-
ing aligned straight with it. The two vanishing points will be 
viewed opposite of each other, one to right and one to the left. 

  

• three-point views direct all lines to three different vanishing 
points. With a three-point perspective a person would view 
the same corner of the building as explained in the two-point 
view, where two of the vanishing points are on the sides with a 
third vanishing point is projected vertically above the horizon.

 

Special Drawings Exercise:
QUIZ:

1. The purpose of a special drawing is to allow the features of 
an object to be shown at their true _________ and ________.

2. An auxiliary view is used when an object has an (2 words) 
____________________.

3. Name the three basic types of auxiliary views.

4. Briefly explain the primary purpose of a sectional view.

5. Name the three sectional view types highlighted in  
this module.

6. Which sectional view type is probably the most common?

7. What is the ANSI number for the most commonly  
used hatch pattern?

8. Which sectional view type allows the view to be  
relocated somewhere else on a drawing?

9. Name the special view that can be relocated on a  
drawing and does not require section lines.

10. How is a cutting plane line labeled when applied  
to a sectional view?
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Chapter 7

drawing types and descriptions

To recap, you have learned to create an object and about the 
different ways in which features can be highlighted on a draw-
ing. From the simplest form to the most complex, features can be 
properly displayed to avoid dimensioning to hidden lines and to 
show their true shape and size. You will now learn about the dif-
ferent drawing types and their descriptions.

design and manufacturing documents
The first design drawing type is the Detail drawing. A Detail 
drawing represents all the necessary information to fabricate an 
item, including the shape description, size description, and speci-
fications of the part. A Detail drawing normally encompasses one 
part although several Detail drawings can be combined on one 
drawing format if it is large enough. As an example, four B-Size 
Detail drawings can be combined on one D-Size drawing format; 
and although eight A-size drawing may fit on a D-size format, it 
is common practice to limit the number of details per D-size sheet 
to four. As a side note, standard parts (purchased parts) do not 
require a detail drawing…unless altered or modified.

When detailing a part with limited features, it is practical to use a 
smaller format size and create a Mono-detail drawing. A Mono-
detail drawing is comprised of only one part to which all the 
necessary dimensions and notes are applied. See Figure 7-1.

 

Figure 7-1

When detailing the components related to an assembly it is 
common practice to detail several items on one drawing. This is 
called a Multi-detail drawing. The Multi-detail drawing is similar 
to the Mono-detail in that each item is individually detailed; 
however, with the use of a larger format size, multiple items can 
be detailed on a drawing. See Figure 7-2.

 

                               Figure 7-2               
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Occasionally when a company makes a detail drawing of a com-
ponent or an assembly, they will offer the item for sale. When 
a customer buys that product it might be necessary for the new 
customer to have some general information about the part. That is 
when a Specification Control drawing is created. A Specification 
Control drawing only gives general information such as overall 
sizes, location and description of mounting holes, general  
features, and so on. The Specification Control drawing keeps 
enough of the manufacturing information secret to prevent a  
customer or competitor from stealing their intellectual property. 
See Figure 7-3 for an example of a Specification Control drawing 
for a Variable Transformer.

Figure 7-3

Next is the Patent drawing. Patent drawing have a flair all of their 
own. Even with today’s CAD programs, it is not uncommon to 
see patents with hand-drawn sketches or even CAD drawings that 
appear to be from the early days of manual drafting. Patent draw-
ings are used to document the intellectual property of a designer 
to prevent others from laying claim to their invention. See Figure 
7-4 for an example of a Patent drawing for an Electric Light 
Fixture that was invented and filed around 1962. Note that it took 
over 3 years before it was officially awarded the patent number 
3,198,462.

 

Figure 7-4
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Another classification of drawing is the Make-from drawing. 
When a purchased part, such as the Eye Bolt in Figure 7-5, needs 
to be altered from its original size to a new size a Make-from 
drawing is needed to reflect the change. This can be a separate 
drawing (Mono-detail) or incorporated in to a larger drawing  
such as in Figure 7-2.

 

Figure 7-5

The description for the Make-from drawing would include the 
original purchase item description along with the word ALTER 
to denote a modified part. The example for Figure 7-5 would be: 
EYE BOLT – ALTER. Because the purchased item is no longer 
its original size, you will need to assign it a new drawing number 
(Mono-detail) or a new part number if its part of a larger drawing. 
Additional information for the item would include the original 
supplier’s name, part number, and the original size. The “as 
purchased” features would be shown using phantom lines to rep-
resent the part prior to the alteration. The “as purchased” dimen-
sions are shown as reference dimensions while the new features 
are dimensioned per drafting standards.

Another use for Make-from drawings is to detail a casting or 
forged part that is machined to its final shape with all included 
features. A casting (see Figure 7-6) generally is a metal part that 
is molded to the rough size and configuration of the finished part. 
The Make-from drawing would then reference the casting part 
number and detail the features that needed to be added to produce 
a finished part.

 

Figure 7-6

The automotive master brake cylinder shown above will need to 
have holes drilled and tapped on the side of the casting to attach 
the brake lines along with machining the nose-end for the internal 
components and mounting holes. All these post-casting features 
would be detailed on a Make-from drawing.

Design and Manufacturing Documents Exercise:

QUIZ:

1. Name the drawing type that is comprised of only one part.

2. Name the drawing type in which several details are  
included on one drawing.

3. Name the drawing type that gives general information, like 
the location for mounting holes, for a part or assembly.

4. Briefly describe the use of a Patent drawing.

5. Briefly describe how a Make-from drawing is  
used to detail a metal casting.

Assembly (Working) Drawings
This next section addresses what kind of drawing is used to detail 
a collection of Detail drawings that make up an assembly. An 
Assembly drawing (sometimes referred to as a Working drawing) 
is a drawing that represents the assembled relationship of two 
or more parts, or a combination of detail parts that are joined to 
form a subassembly or a complete unit. The levels of an Assem-
bly drawing are dependent on the complexity of the assembly 
being detailed.

Assembly drawings can be comprised of a single sheet in which 
all the supporting detail drawings are individual drawings on that 
sheet. Or, they can be a combination of the assembly detail on 
one sheet and all supporting detail drawings incorporated into 
a multi-sheet drawing package. When setting up an Assembly 
drawing package (whether it is a single sheet or multi-sheet) it is 
common practice to show the assembled components on the first 
sheet of the package while the individual details are shown on 
subsequent sheets. See Figure 7-7.
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Figure 7-7

The Assembly drawing sheet typically includes the drawing 
format, title block information, a Bill of Materials (BOM), and 
the assembly. The assembly can be depicted in several ways and 
the best method is often dependent on its complexity. A common 
practice is to show the assembly in an exploded or expanded 
state. The exploded assembly graphically describes the assembly/
disassembly relationship of the separate components. This allows 
for a better understanding by the manufacturer and assembler on 
how the parts relate to one another. This detail method is a little 
more time consuming than standard orthographic projections 
although it can be worth the extra time if it avoids confusion and 
ensures a properly assembled item. 

After the assembly has been placed on the drawing and the 
method to depict the various parts has been applied, it is time to 
identify each component with an Item Balloon that will refer-
ence that item to the corresponding item in the BOM. The Item 
Balloon is attached to the part by means of a leader line with a 

circle at the end and corresponding number inside. The circle, or 
Balloon, is usually 5/8” (0.625) in diameter and the text height 
of the number is 1/4” (0.25). The leader line can terminate with 
an arrowhead touching the edge of the item or with a “~” when 
placed on the surface of the item. Since aesthetics is a sign of 
a well conceived drawing, it is common practice to arrange the 
Item Balloons in a row or along an imaginary line. This presents 
a professional looking drawing.

Should an exploded assembly not be necessary on a drawing 
because of its simplicity, the use of orthographic projections is 
required. When this projection method is used, it may become 
necessary to add Broken sections where needed to highlight 
hidden or recessed items. See Figure 7-8 for an example of an 
orthographic assembly with Broken sections.

 

Figure 7-8
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Occasionally, a Full Sectional Assembly drawing is used to il-
lustrate the location of separate items within an assembly. This is 
similar to the exploded assembly view except the parts are shown 
in section with different hatch patterns applied to depict the dif-
ferent components. See Figure 7-9.

 

Figure 7-9

purchased parts
Purchased parts are those that are manufactured and available 
from a supplier. When designing a new part, it is best to take a 
moment to research whether or not a similar item already exists. 
It is more economical to purchase some items than to have them 
made from scratch. Where do you begin your research? With the 
vast amount of information available on the internet and the vari-
ous search engines at your finger tips, it makes perfect sense to 
start with this resource. Should you find the exact item or some-
thing very similar, purchase that item instead of fabricating a 
new part. The purchased part already has all the design work and 
drawings along with any statistical and safety reports that may be 
required. This will save you a lot of time and money. Should you 
not find exactly what you are looking for, remember that a pur-
chased part can usually be altered to perform your needed task. 
Aside from having to document your alteration with a drawing, 
you will still be saving money on the project.

Purchased parts are shown in the Bill of Materials (BOM) on an 
Assembly drawing. It is customary to include them on the list 
after the manufactured items are listed and to group them by sup-
plier whenever possible. This helps the person who will be buy-
ing these components make sure that the right part gets ordered 
from the right supplier.
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Chapter 8

dimensioning systems

When producing a drawing, first draw the features of the object 
then add the dimensions to describe the features of that object. 
Dimensions are placed on a drawing along with lines, symbols, 
and text, to define the geometric characteristics of the object. 
The purpose of dimensions is to provide information regarding 
the exact size, shape and location of each feature of the object so 
that it can be manufactured and inspected. These dimensions are 
not those values a drafter uses for drawing the object. This sec-
tion covers the rules, nomenclature, features, and the systems of 
dimensioning along with an explanation on tolerances. The rules 
stated here are derived from the American National Standards 
Institute, ANSI Standards for dimensioning.

rules of dimensioning & nomenclature

Whether the drawing is a very simple configuration, like a washer 
(two circles of different diameters), or a complex configuration, 
like that of a jet engine’s fuel valve body which has many holes 
and features that interconnect and mate to other components, the 
drawing must be dimensioned so that it can be manufactured. Re-
member that the values used for drawing the object are not neces-
sarily the same ones used to dimension the object. The process 
used for dimensioning is based on fundamental rules adopted by 
ANSI Standards for dimensioning. By following these rules you 
should be able to fully dimension an object and have it ready for 
manufacture and inspection.

1. Sufficient dimensions must be shown so that sizes, shapes, 
and contours of an object can be determined without  
performing calculations or assuming distances.

2. Dimensions must be clearly stated.

3. Dimensions must be selected to minimize the a 
ccumulation of tolerances.

 

4. Each dimension is identified only once.  
No duplicate dimensions.

5. Avoid placing dimensions to hidden lines.

The terminology of the components that make up a dimension 
were discussed with the other Alphabet of Lines. Here again is 
the definition of each dimensional component as they relate to 
linear and ordinate dimensioning. 

Dimension line:
• Line with arrowheads at each end
• Shows direction and extent of a dimension
• Numerals indicate the number of units of a measurement

Extension Line:
• Aligned with feature and extends beyond object
• Normally shown perpendicular to dimension lines

Leader:
• Line used to direct a dimension, note, or symbol  

to the intended location on a drawing
• Line is usually angled
• Ends with arrow, dot, or wave(~)
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Dimensions not to scale:
• Marking are used to show when a dimension is not  

shown at actual size or location
• Use foreshorten dimension line symbol to indicate size

dimensioning of features

All objects require two types of dimensions to correctly describe 
its features: size and location.

Size:
• Describes the general external features by their length,  

width, and thickness. 
• Describes internal features such as a hole diameter,  

a slot width, etc.

Location:
• Describes the location of internal and external features such 

as a notch, groove, hole, etc.

Some common drafting features include:
Drill Holes
• One of the most commonly dimensioned features on a draw-

ing. Can be “through” (usually noted as THRU) or “blind”. 
A blind hole is one which does not go completely through 
the material and is dimensioned to the depth ( x ) of the full 
diameter.

Diameter
• The length of a straight line passing through the center of a 

circle (hole) and ending at the circumference on each end.
• The symbol ( Ø ) is preceded by the value. 

Counterbore ( v )
• Larger hole to a specified depth
• Used for clearance of below-the-surface hardware
• A Spotface is similar to a counterbore but without depth
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Countersink ( w )
• Have angled sides
• Used to obtain a flush  

or below-the-surface  
mounting area

Tooling used to make these typical features include Drill bits 
(twist drill), Counterbore bits, and Countersink bits for 
standard hardware.

Fillets, rounds, & radii
• Fillets are rounded internal corners
• Rounds are rounded external corners
• Radii (plural of radius) can be either internal or external

Slots
• An elongated, oblong, shaped feature
• Usually an internal feature with full radius ends

Chamfers
• A machined angle to break a sharp corner
• Can be internal or external
• Angle is normally specified

Dimensioning of Features Exercise:

QUIZ:

1. Name the feature that is one of the most commonly dimen-
sioned features on a drawing.

2. What term describes the diameter of a hole in regards to 
other general internal features?

3. Name the feature that also represents a spotface.

4. Name the feature that has an elongated shape.

5. Draw the symbol which describes the diameter of a hole and 
write the special character code that generates this symbol.
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dimensioning systems
There are various dimensioning systems used to properly 
describe an object for manufacture. The system used may be 
defined by a company’s drafting standards or by the best practices 
used in the industry. There is no restriction against starting with a 
particular system and including dimensions from another system. 
For example, if an object is dimensioned using the linear unidi-
rectional system, it is appropriate to include dimensions based on 
the tabular system if it will better provide the information needed. 
Likewise, if an object is dimensioned with the arrowless sys-
tem, it is common practice to include unidirectional dimensions 
to control the size or location of a feature to avoid unnecessary 
tolerance stack-up and provide fitting the feature with its  
mating part.

 

Figure 8-1

Unidirectional: (most common) Figure 8-1A
• Implies that the dimension text is placed in one direction, 

usually horizontally, and parallel to the bottom edge  
of the drawing.

Aligned: (rotated) Figure 8-1B
• Dimensions are aligned to the drawings bottom edge for 

horizontal dimensions and rotated, parallel to the right side, 
for vertical dimensions (never to the left side). This system 
is commonly used for architectural drawings and rarely for 
mechanical drawings.

 

Figure 8-2

Tabular: Figure 8-2
• Used when a feature can be identified by several dimensions
• Used to identify multiple similar features (such as holes) in 

one drawing view

Arrowless (Ordinate):
This system is similar to Baseline dimensioning for linear di-
mensioning except the overlapping extension lines at the Base 
(Datum) have been eliminated and the dimension values have 
been placed closer to the object. This system is very handy from 
a manufacturing point-of-view; however it can lead to a stack-up 
of tolerances if not used with an occasional linear dimension for 
specific features.

• Feature and tolerance dependent
• Dimensions extend from a “datum” point
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Dimensioning Systems Exercise:

QUIZ:

1. Name the dimensioning system that is most commonly used.

2. Name the dimensioning system rarely used for  
mechanical drawings.

3. Explain when the Tabular dimensioning system  
might be used.

4. What system is similar to baseline dimensioning  
that does not use arrowheads?

5. Explain the benefit of incorporating two or more  
dimensioning systems together on a drawing.

tolerances
All parts must be produced to some measurable acceptable size 
so when they are assembled they will fit and operate properly. 
The most proficient machinist operating the most accurate equip-
ment must be allowed some variation in dimensions when pro-
ducing a part. This allowable variance is called a tolerance. The 
concept of tolerances was developed to ensure that a part made 
at one manufacturing facility can be used with one produced at 
another facility. Technical drawings provide an appropriate varia-
tion with each dimension so parts will fit, function as required, 
and still be economical to manufacture. The saying ‘tolerance = 
money’ implies that the tighter the tolerance, the higher the price 
to manufacture the object. Like dimensioning, proper use of toler-
ances is a vast subject and will be covered only briefly to provide 
a general understanding. 

Here are some general terms and definitions associated  
with tolerances.

tolerance - The total amount by which a dimension is permitted 
to vary. The tolerance is the difference between the upper (maxi-
mum) and lower (minimum) limits of a dimension.

Limits of size (Figure 8-3) - These are limits or limit dimensions 
that describe the extent within which variations of geometric 
form and size are allowed. They are the specified maximum and 
minimum sizes of a dimension, as shown below.

 

Figure 8-3

unilateral tolerance (Figure 8-4) - A tolerance in which varia-
tion is permitted in one direction from the specified dimension. 
Examples of this type of tolerance are shown below.

 

Figure 8-4

Bilateral tolerance (Figure 8-5) - A tolerance in which variance 
is permitted in two directions from the specified dimension, as 
illustrated below. If the upper and lower variance is the same 
value, this is a Symmetrical tolerance.
 

Figure 8-5
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Minimum and Maximum tolerance (Figure 8-6) - Sometimes 
only one dimensional limit is needed. When this is the case the 
abbreviation MIN or MAX appears immediately following the 
dimension. This situation often occurs on such part features as the 
depth of holes, the length of threads, corner radii, chamfers, etc. 
Single limits are used where the feature that is dimensioned can 
exceed the dimension in one direction only without concern.

 

Figure 8-6

mating parts - Parts that will be assembled together, such as a 
shaft in a hole, a screw in a tapped hole, or a key in a slot.

fit - The looseness or tightness of two mating parts when as-
sembled.

allowance - The fit between two mating parts when they are at 
their closest size. IE: When a shaft is at its largest diameter and 
its mating hole is at its smallest diameter.

Interference fit - This occurs when one feature is larger than the 
feature in which it is supposed to mate, causing the two parts to 
be pressed or forced together. Also known as a Press fit. 

Clearance fit - A type of fit that provides clearance, or space, be-
tween mating parts at all size extremes. Also known as a Slip fit. 
Dimensioning Systems Exercises:

1. Using an A-Size format, draw the following object 
 and apply any of the different dimensioning systems 
 to describe the object.

 

 - Outside shape: 3.500 X 2.000
 - Small diameter holes: Ø.375 X2; centered on the  

width, 1.250 to the left of the Ø1.000 hole, and  
spaced 2.500 on center.

 - Large inside diameter: Ø1.000`.003;  
centered on outside shape.

 - Large outside diameter: Ø1.500
 - Flange thickness: .500
 - Overall height: 1.250
 - Corner radii: .12 four places

2. Dimension with new values for the same part 
 that is scaled up 1.25 percent.

3. Dimension with new values for the same part 
 that is scaled down .80 percent.
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Chapter 9

Basic mechanical hardware

In the world of manufacturing and mechanical design, hard-
ware is the main component of almost any item we design. Take 
the cellular phone for instance. Without the threaded fasteners 
(screws), washers, and spring, the outside covers would not stay 
together and the ear piece would not stay open when flipped 
up. You would be carrying around a bunch of loose electrical 
components that would be subjected to damage. Because of its 
importance, you need to be familiar with the common types of 
hardware used in manufacturing.

The term hardware encompasses all the locking, holding, and 
positioning items used to build an assembly. This ranges from 
screws, bolts, washers, nuts, dowels, and springs which are the 
major categories of hardware.

threads and fasteners
Threaded fasteners are frequently used in the assembly of a ma-
jority of items from toys to aircrafts and everything in between. 
They are perfect for securing parts together while providing a 
strong connection between those parts. Here you will learn to 
describe how to represent threads associated with fastening, inter-
pret a thread note, and describe some common fastener types.

First is to identify the ridges that make up the holding part of a 
fastener. These are called the thread form and there are several 
different series of thread forms. The most commonly used series 
is called the Unified Thread Form Series. It is a compromise 
between the American National and British Whitworth forms 
and is mechanically interchangeable with the American National 
form. When detailing threads on a drawing, there are three differ-
ent ways to represent them: detailed, schematic, and simplified, 
though only one is commonly used for drafting purposes.

Detailed – Provides the complete detail of the thread. It is not 
commonly used for it is time consuming to draw.

 

Schematic – Not commonly used except for a general depiction 
of threads on a Specification Control drawing.

 

Simplified – Most commonly used.

 

 

Figure 9-1
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In the simplified method, threads are drawn using the major 
and minor diameter values as identified on a thread chart. For a 
shaft, such as a bolt, the major diameter is drawn with an Object 
Line while the minor diameter, also known as the tap drill size, 
is drawn using Hidden Lines. The opposite is true for a hole. A 
tapped hole will use a Hidden Line for the major and an Object 
line for the minor diameters. Refer to the drawings above for the 
correct depiction when detailing the side view of threads.

In addition to detailing threads on a drawing, a drafter must be 
able to read and identify a thread note. The thread note is the call-
out on a drawing that identifies the type of thread to be used on a 
part. There are English and Metric threads available; however, for 
this subject we will reference English threads only. By under-
standing the basic components of the English thread note you can 
apply that knowledge to similar notes for metric threads. 

thread note (See Figure 9-1)

Interpret the Thread Note: .250-20 UNC-2B 
(also written as: ¼-20 UNC-2B)

Size: (The first value)
• Denotes the major thread diameter.
 o  In this example: Ø0.250 inches
• Expressed in either decimal or fractional form.
• Drawn as a hidden line for holes or as an object 
 line for shafts.

Threads Per Inch (TPI): (The second value)
• The number of threads per inch of length or depth.
 o In this example: .250-20 indicates there  

will be 20 threads per inch;
 o While .250-28 indicates there will be  

28 threads per inch.
• Value correlates to the Series depending on size.
 
Form & Series: (The third value)
• The standard Form here is Unified National (UN).
• There are three common Series:
 o Coarse (C)
 o Fine (F)

 o Extra Fine (EF)
 o Examples: UNC, UNF, or UNEF

Class of Fit: (The forth value)
• Class 1 allows the greatest clearance between mating threads.
• Class 2 is the standard for most applications.
• Class 3 allows the closest fit between mating threads. 
 o Used for critical applications, like aviation

External / Internal: (The fifth value)
• A = External (a threaded shaft such as a bolt)
• B = Internal (a tapped hole)
 

For the Thread Note in Figure 9-1 there is some additional 
information regarding the tapped hole. (NOTE: This thread call-
out does not follow current drafting standards and is for general 
information only) The first line of the note reads: #7 (.201) DR – 
1.00 DP. This means to use a numbered drill, #7, which is .201 in 
diameter and drill to a depth of 1.00. The second part of the note 
reads: .250-20 UNC-2B - .75 DP. This means to tap the drilled 
hole for a ¼-20 thread to a depth of .75.
Thread notes are linked to specific fastener types when used for 
manufacturing the product. Threaded fasteners come in a variety 
of different types to accommodate a variety of different applica-
tions. Fasteners allow an assembly to be quickly put together 
and disassembled when necessary; unlike other methods, such as 
welding.
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Three of the most common fastener types are bolts, screws, and 
nuts. They come in various shapes and types. The head configura-
tion on bolts and screws, for example, vary because their shape 
and drive-style are dependent on their application. Below are 
some general characteristics of these common fastener types.

Bolts:
• Major thread diameter generally ¼” diameter or larger.
• Bolt Head Styles:
 • Allen Head (internal hex design)
 • Hex (External shape)
 • Square
• Bolt Head Types:
 • Button Head
 • Flat Head: (Used in a countersink hole or finishing 

washer)
 • Socket Head

Screws:
• Major thread diameter generally smaller than ¼” diameter.
• Come in various shapes and types.
 • Cap Screws, Wood Screws, Machine Screws, Sheet 

Metal Screws, Self Drilling Screws, etc.
• Screw Head Styles:
 • Allen Head (internal hex design)
 • Hex (External shape)
 • Slotted
 • Phillips-Head
 • Torx
• Screw Head Types:
 • Button Head
 • Flat Head
 • Oval Head
 • Pan Head
 • Socket Head
Nuts:
• Come in various shapes and types.
 • Hex, Nylon Insert Lock, Jam,  

Wing, Acorn, Square, etc.

Threads and Fasteners Exercise:

QUIZ:

1. What is the main type of hardware that holds a  
majority of items together?

2. List the three different types of thread representations.

3. In the thread note: ½-11 UNC-2A, what does  
the ½ represent?

4.  In the thread note: ½-11 UNC-2A, what does  
the 11 represent?

5. In the thread note: ½-11 UNC-2A, what does  
the “A” represent?
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other Basic hardware

There are other types of common hardware used to assemble jigs, 
fixtures, machines, and other manufactured products. Due to the 
vast amount of items identified as hardware, we will narrow our 
discussion to just a few: dowels, springs, and washers.

Dowels: Dowels are made of precisely ground metal rod that is 
sectioned into short lengths and used to obtain accurate alignment 
of two mating parts. They are normally used in pairs. One dowel 
is used to locate while the other prevents rotation. Dowels are 
usually used in conjunction with threaded fasteners. The dowels 
provide the alignment while the fastener provides the force to 
hold the parts together.

Springs: There are three major types of springs and they each 
serve a particular function. The first type is a Compression 
Spring. It is made by a coil of wire formed around a shaft called 
a mandrel and has a generous amount of space between each 
coil. The compression spring is used to support an item and will 
compress under a load. Examples include the spring used in a ball 
point pen and in the mattress of a bed. The second type is the Ex-
tension Spring. It is also made by coiling wire around a mandrel 
except instead of space between each coil the wire is wound next 
to each other and loops are formed on each ends. The extension 
spring is used to pull things together and will extend under a load. 
Some examples would be the springs used in some garage door 
assemblies, carburetors, and around the perimeter of trampolines. 
The third type is the Torsion Spring. This spring is formed by 
coiling wire around a mandrel and leaving the ends long. Torsion 
springs can be wound to either pull the ends together or push 
them apart. A clothespin is a common example of the use for a 
torsion spring as is the little torsion spring that opens the lid of a 
CD Player. On a larger scale, before gas struts, the hood of an au-
tomobile was once held open by torsion springs. See Figure 9-2.

Figure 9-2

Washers: These come in various shapes, types, and sizes. They 
are made of various materials such as metal, plastic, rubber, 
or leather. When placed beneath a nut or fastener, washers can 
distribute pressure over a larger surface area. They can also help 
prevent leakage such as with a garden hose, or to prevent a fas-
tener from loosening.

• Flat and Fender:
• Lock:
 o Split Lock, External Tooth Lock (also called a Star 

Washer), and Internal Tooth Lock.

Compression Spring Extenson Spring

Tension Spring
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Chapter 10

the Welding process

The task of welding is usually performed by a Welder. This per-
son is usually certified in the various disciplines of welding and 
requires a significant amount of training. For drafting purposes, 
here is an overview of the subject of welding.

Welding is a form of fastening materials of the same type to-
gether. Welding permanently attaches two similar metals together. 
This differs from the hardware fastening types discussed above 
which are semi-permanent, meaning they can be easily removed 
with the proper tools and can be applied to dissimilar materials. 
Welding occurs by heating the material to a high enough tem-
perature that it begins to soften or melt. This is done in a local-
ized area to bond the two metals together into one piece. When 
the process is properly done, the welded joint will be as strong, or 
stronger, than the original metal.

 

 

There are various methods and types of welding that are used in 
each of the major drafting disciplines that will be covered in this 
module. Welding, also called weldments when two or more items 
are connected together, is used in the architectural and civil fields 
in the form of connecting rebar together for the foundation of a 
building, connecting I-beams that form the skeleton of a building, 
or connecting piping that is used to transfer liquids or hazardous 
gases above or below ground. The mechanical field uses weld-
ing to form the chassis used for automobiles, the framework for 
electrical equipment, as well as the airframe for small aircraft to 
attach the various links that form a very rigid and safe structure.

Welding Processes
Welding is accomplished by using one of several processes. Some 
processes are more common than others. Oxyacetylene, arc, and 
spot welding are the three most commonly used methods for the 
process of welding.

Oxyacetylene is the name used to describe oxygen gas welding. 
Two cylinders (bottles) of pressurized gas are combined with 
separate hoses attached to a mixing device that also functions 
as the handle used by the welder. One of the cylinders contains 
oxygen and the other can be a burning fuel such as natural gas, 
propane, or propylene. When these fuels are mixed in the correct 
proportions and ignited, it causes a flame that is hot enough to 
melt softer metals. Figure 10-1

                                
                                        Figure 10-1
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Arc welding is a general term describing several methods of 
welding that use electricity to cause an arc hot enough to melt 
metal. This method uses a work cable that is temporarily clamped 
to one end of the metal pieces being welded while the welder 
holds the other end known as the electrode holder. With electric-
ity going to the electrode holder and a welding rod in place, when 
brought close to the metal, the electricity jumps the gap causing 
a bright arc. Special welding hoods are used to protect your eyes 
from the intense brightness. Figure 10-2

                        Figure 10-2

Spot welding is similar to arc welding in that electricity is applied 
to the two metals. This method uses a temporary application of 
high electrical current between two electrodes. When the metals 
are placed between the electrodes, and the electricity is turned on, 
the path of the current passes through the metals melting them 
together at that one spot. This type of welding is used mainly for 
thin materials such as sheet metal. Most metal car bodies are as-
sembled by robotic spot welders. Figure 10-3

 

                figure 10-3

Welding symbols
Welding symbols are established by the American Welding 
Society (AWS) to allow a uniform standard in the drafting and 
placement of symbols. The document, known as ANSI/AWS 
A2.4-93 (Standard Symbols for Welding, Brazing, and Nonde-
structive Examination) details how the welding symbol is drawn 
and identifies each of the various line types, symbols, call-outs, 
and weld type descriptions.

This basic weld symbol is made up of a leader line with an arrow, 
a reference line, and a tail which may or may not be used depend-
ing on the type of call-out. See Figure 10-4. The reference line is 
the horizontal line that will indicate the weld type symbol and all 
the dimensional values associated with the correct size and loca-
tion of the weld. The tail of the weld symbol is used to identify a 
specification, a process (such as OAW for oxyacetylene welding, 
or RSW for resistance spot welding), or other type of reference. 
The tail is omitted when no reference is used.
 

Figure 10-4

The weldment surfaces are identified by the side that the weld 
symbol arrow points to; this is called the Arrow Side while the 
opposite surfaces are identified as the Other Side. Figure 10-5
 

Figure 10-5
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When a weld type is to be applied to the arrow side the informa-
tion and proper symbol is attached to the lower side of the refer-
ence line. However, if the weld type will be applied to the other 
side then the information and proper weld symbol are shown 
above the reference line. Additionally, if a weld type applies to 
both sides of the joint then the information and proper symbols 
and shown above and below the reference line.

There are two commonly used supplementary symbols that can 
be attached to the weld symbol. They are the Field Weld flag 
and Weld All Around circle. The Field Weld flag denotes that the 
pieces of the weldment are to be set in place at the job site before 
they are welded together. The Weld All Around circle is used to 
denote when a continuous bead of weld is to be applied where the 
end meets up with the beginning, such as when welding a pipe 
seam or mounting a post to a flat plate. Figure 8-10

 

Figure 10-6

Welding types and their symbols

The following information will identify the various weld types 
and their correlated weld symbol. The weld type symbol is 
normally the next item placed on the weld symbol. The weld 
type symbol identifies the form of the weld being applied to the 
surfaces. Through the use of dimensional values, you can specify 
the size of the weld leg length, the distance of separation (root 
opening), and the angle of the surfaces being welded. (Note: The 
following figures show a graphical representation of the weld-
ment types and not the penetration of the weld metal.)

fillet Welds: A fillet weld (pronounced “FILL-it”) is used to 
fasten two pieces of metal together that have been assembled 
to form a T-joint, L-joint (corner joint), or lap joint (one piece 

placed on top of another piece). The fillet weld is roughly trian-
gular in cross-sectional shape. When both legs of the fillet weld 
are the same length, the size is given once, as shown in Figure 
10-7, 10-8, and 10-9. When the leg lengths are different in size, 
the vertical dimension is shown ahead of the horizontal dimen-
sion as shown in Figure 10-10. See Figures 10-11 and 10-12 for 
examples of a Corner joint and a Lap joint.
 

Figure 10-7: Fillet weld (T-joint) with equal legs on arrow side.

Figure 10-8: Fillet weld (T-joint) with equal legs on other side.
 

Figure 10-9: Fillet weld (T-joint) with equal legs on both sides.
 

Figure 10-10: Fillet weld (T-joint) with different leg lengths on 
arrow side.
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Figure 10-11: Fillet weld (Corner joint) with equal  
legs on arrow side.
 

Figure 10-12: Fillet weld (Lap joint)  
with equal legs on arrow side.
 
Groove Welds: Groove welds can take on several different con-
figurations; from the plain Square Groove weld (butt joint), Bevel 
Groove, V-Groove, to the U-Groove and J-Groove welds. Al-
though some look very similar, they each have different roles in 
regards to strength and penetration of the weld. Take the Square 
Groove weld. This weld type is used to make edge-to-edge joints 
where the two pieces have a tight joint or a slight separation. 
When a separation is involved, this distance is known as the root 
opening. It is referenced inside the square groove symbol. See 
Figure 10-13.
 

Figure 10-13: Square Groove weld showing root opening.

Next is the Bevel Groove weld. This weld type is created when 
one piece is square and the other piece has a chamfered edge that 
spans the whole thickness of the piece. The angle of the chamfer 
is called-out on the weld symbol and the perpendicular line of the 
bevel groove symbol is always drawn on the left side, regardless 
of the orientation of the weld itself, as shown in Figure 10-14.
 

Figure 10-14: Bevel Groove weld.
 
Another Groove-type weld is the V-Groove weld. This weld type 
is similar to the Bevel Groove weld except that both edges are 
chamfered and that the angle given in the weld symbol is the 
included angle for the opening to be welded. See Figure 10-15a 
for an example. If the depth of the V is not full thickness, or half 
thickness in the case of a V on both sides, the depth is given on 
the left of the weld symbol. See Figure 10-15b.

 

Figure 10-15a: V-Groove weld on arrow side and full thickness.



93

fundamentals of draftting

 

Figure 10-15b: V-Groove weld on both sides and  
partial thickness.

The next two Groove-type welds are similar in that they both 
use a concave treatment to the edge, or edges, of the pieces to be 
welded. The J-Groove weld has one piece with a square edge and 
the other with a concaved edge. As with the bevel groove weld, 
the perpendicular line is always drawn on the left side, and the ar-
row points to the piece that receives the edge treatment as shown 
in Figure 10-16. The U-Groove weld is the same except that both 
edges receive the concave treatment as shown in Figure 10-17.

 

Figure 10-16: J-Groove weld on arrow side.

 

Figure 10-17: U-Groove weld on other side.
 
Resistance Welding: This type of welding involves passing a 
momentary electrical current between two electrodes in which the 
base materials are clamped. The two common weld types related 
to this method are Spot welding and Seam welding.

Spot welding is the most commonly used type of welding when 
thin materials need to be permanently bonded together. Sheet 
metal parts such as auto body components and air handling duct 
work are the usual recipient of spot welding. The process letters 
of RSW (resistance spot welding) are placed behind the weld 
symbol tail to identify this weld type. See Figure 10-18.
 

Figure 10-18: Spot weld (RSW) on both sides.

Seam welding is similar to spot welding except that the spots 
overlap each other which make a continuous weld seam. This 
method of welding is used when high shear strength is necessary 
or when connecting two edges together for a leak-proof seam. 
The process letters of RSEW (resistance seam welding)  
are placed behind the weld symbol tail to identify this weld type. 
See Figure 10-19 for an example.
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Figure 10-19: Seam weld (RSEW) on both sides.

Two other forms of weld types are Plug welds and Slot welds. 
These two weld types are very similar to one another. They both 
apply when joining overlapping metal pieces (similar to the prin-
ciple of spot welding) except the material is thicker and therefore 
the pieces must be welded together. Plug welds use a series of 
holes in one of the pieces to allow welding of the two metals 
together. Slot welds use large slots in one of the pieces which 
allows for more weld material to be applied which usually yields 
a stronger bond for higher shear strength. See Figures 10-20 and 
10-21 for examples of these two weld types.

 

Figure 10-20: Plug weld.

 

Figure 10-21: Slot weld.
Welding Exercise:

QUIZ:

1. How strong is a properly welded Joint?

2. List the three most commonly used welding processes.

3. For oxygen gas welding, one cylinder is oxygen and the 
other is what kind of cylinder?

4. Why is a special hood worn when arc welding?

5. Name the parts that the metal is placed in between (current 
flows through them) when spot welding.

6. Welding symbols are standardized by what document?

7. Name the three main components of a weld symbol.

8. Which part of the weld symbol can be omitted if no refer-
ence is used?

9. Name the two sides that are used to identify the weldment 
surfaces in relationship to the weld symbol.

10. Name the two supplementary symbols explained  
in this module.
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11. Name the three types of Fillet Weld joints.

12. Explain this weld symbols type, weld side, and weld size. 

13. Explain this weld symbols type, weld side, and weld size.  

14. Draw the weld symbol for this weld type.  

15. Identify this weld type and its process letters.
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Chapter 11

Project: Chuck Jaw

In this module, the mechanical drafter will understand the proce-
dure to design a Chuck Jaw that will be used to shape a cylin-
drical component called a Hub. You will be guided through the 
various phases that you are likely to encounter when designing a 
machine tool such as a Chuck Jaw. You will also develop a better 
understanding of the design process from the beginning (the need 
for a tool) to the end (the completed tool ready to produce the 
Hub).

important note: for step by step instructions on how to create 
the Chuck Jaw project using A+CAD see chapters 13 – 17 of the 
text “Inside A+CAD 2008”.

First, you need to know what the function of a Chuck Jaw is 
before you design one for the Hub you will create. A Chuck Jaw 
is a component of a holding device called a Chuck (Figures 11-1a 
and 11-2). A chuck is a component of a machine called a Lathe 
(Figure 11-1); and a lathe is a machine that is used to cut cylindri-
cally shaped material, such as a shaft or round bar, by turning the 
material in a rotary motion like that of a driveshaft of a car or the 
blades on a fan.

Figure 11-1: Lathe - Courtesy Micro-Mark tools

   

 

Figure 11-2: Chuck assembly 

The lathe will produce the necessary features of the Hub. To do 
this, the lathe uses a tool post that holds a cutting tool that will 
be advanced into the spinning material to cut the features of 
the Hub. In some cases, special jaws need to be made to hold a 
part while it is being machined by the lathe. The design for your 
Chuck Jaw is one of these special cases.

In other words, to produce the Hub, the mechanical drafter will 
have to design the special Chuck Jaw first. The initial step is to 
determine which features from the Hub will be used on the Chuck 
Jaw to support the part while it is being machined. From this 
knowledge you should be able to design the Chuck Jaw and pro-
duce a detailed drawing from which the part will be fabricated.

The design process begins with a detail drawing for the Hub. 
(This completed drawing is shown in figures 11-3, 11-4, and 
11-5.) You need to request from your machine shop to have a 
set of “soft” jaws manufactured to hold the material for the Hub 
while the additional features are added. Soft jaw is the term used 
to describe jaws that are specifically made to hold a specific part 
during a machining operation. They are usually made from a soft 
material, such as Aluminum or Steel, as opposed to the extremely 
hard material of standard jaws. Soft jaws are used to prevent sur-
face damage by the clamping force needed to hold the spinning 
material in place during the cutting operation. 

Your objective is to design and detail this set of soft jaws that will 
mount on the 4-jaw chuck shown in Figure 11-2 that will hold the 
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Hub shown in Figure 11-4 during the machining operation. To 
begin, identify the surface that the jaws will clamp onto and the 
surface that the jaws will rest upon.

Figure 11-3: Hub detail drawing

Figure 11-4: Hub (Solid model isometric view)

 

Figure 11.5: Top view of Hub

 

 

Figure 11-6: Side views of Hub
Now that the clamping and resting surfaces have been identified 
(Figures 11-5 & 11-6), it is time to explore some other design 
requirements that need to be established before designing the 
chuck jaw. The next element is to figure out how the chuck jaw 
will mount to the chuck (Figure 11-7).

The 4-Jaw Chuck as shown in Figure 11-7 is a simple representa-
tion shown for educational purposes only. This chuck is designed 
to have replaceable jaws which are illustrated by the four keys 
(shown in orange) that have two threaded holes for mounting 
bolts and one dowel for locating the jaws (Figure 11-8a & b). 
This particular chuck key has two tapped holes sized for 7/16-14 
UNC bolts and one Ø.500 dowel used to locate the chuck jaw in 
an exact location in relation to the key.
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Figure 11-7: Sample of a 4-Jaw Chuck

Figure 11-8a: Sample Chuck Key

Figure 11-8b: Sample Chuck Key Detail

Notice the dimensions that explain the location of the two  
7/16-14 UNC-2B tapped holes in relationship to the Ø.500  
dowel. The dowel is the main feature that locates the two holes  
in regards to the Chuck Key. (Remember, a dowel is precise in 
size so a standard tolerance does not apply.) You will need to  
reference all of these dimensions in your design of the  
Chuck Jaw. 

There is one more dimension that you will need to know before 
you begin the layout. That dimension is the height of the Chuck 
Key which extends above the surface of the Chuck (Figure 11-9). 
This is necessary to insure enough clearance for the jaws to  
move in and out on the keys when the jaws are tightening  
against the Hub.

 

Figure 11-9: Chuck Key height extending above Chuck

Layout of the Chuck Jaw Drawing

To begin this drawing, start with some basic drafting and draw-
ing setup information. This is going to be a Mechanical Format 
drawing using the English decimal units as opposed to the ISO 
metric units. Because you are using the English units, you will be 
using the orthographic projections for the Third Angle Projection 
scheme.

NOTE: process notes will be added to alert you of time-saving 
tips and other information that will aid you in producing a well-
defined drawing.

Step 1:  Start a new drawing using a C-Size (22 x 17) Mechani-
cal Format (ANSI-C) layout. 
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Step 2:  Set up Layers for your Object lines, Center lines, Hidden 
lines, Phantom lines, Cutting Plane lines, Dimension 
lines, and Notes. While in the Layers Explorer dialog 
box, set the layer colors and line weights. There is a 2 to 
1 aspect ratio for line weight of the Object and Cutting 
plane lines to the supporting lines (all the other line 
types). For your drawing, set a line weight of .60 mm for 
the Object and Cutting Plane lines and use a line weight 
of .30 mm for the remaining supporting line types.

process note: Use a Text Style (Font) of RomanS for all notes 
and dimensions unless otherwise instructed.

Step 3:  Set your Layer Control to the Note layer and add the 
following information in the Title Block: the name of 
the drawing: CHUCK JAW; a Drawing Number (such as 
082257); the Standard Tolerances of: .XX = ±.01, .XXX 
= ±.005, .XXXX = ±.0005, and a = ±30’; note that you 
are using THIRD ANGLE PROJECTION and show the 
proper symbol indicating this projection scheme; and 
add your name as the DRAFTER. (The CHECKER will 
be the person who reviews your drawing)

process note: Text height of information in the Title Block will 
vary. The drawing name should be .25 (1/4”) high while the 
remaining text will be between .07 and .16 in height. Adjust as 
necessary to make the information fit yet readable when printed.

Step 4:  While still on the Note layer, add the following informa-
tion in the upper left corner for your General Notes:

NOTES: (UNLESS OTHERWISE SPECIFIED)
1. MATERIAL: ALUMINUM 6061 T4 – T6
2. BREAK ALL SHARP CORNERS AND EDGES.
3. FINISH: 63 R.M.S. DO NOT ANODIZE.
4. MARK PART NUMBER ON FRONT SIDE.

The heading, NOTES, has a text height of .25 (1/4”) while the 
body of the notes has a text height of .19 (3/16”).

process note: Before you start designing your project, set up 
your Dimension Settings at this point so that they are ready 
when you to detail your part.

Step 5:  Use .125 (1/8”) for arrow size, extension line  
extension (extend lines past), and text height. Use  
.062 for extension line outset (offset from origin).  
Set your initial Tolerance Text Decimal places and the 
Linear Dimension Decimal places to 3 (default is 4). 
Finally, under the Units tab, set the zero suppression  
for Linear Dimensions to suppress Leading zeros, and 
set the suppression to “both zeros” for Angular  
Dimensions. (Remember that the Comprehensive  
scale factor (default of 1.0000) may need to be  
adjusted to produce the desired text height on the  
printed copy should you use a Paper Space scale of 
anything other than 1:1.)

Process Note: As stated earlier, your will design one “soft” 
Chuck Jaw that will fit on the illustrated 4-Jaw Chuck shown in 
Figure 11-7. Here is some further information about the size of 
the Chuck Jaw (referred to as “part” in the following steps) and 
some required features that need to be designed into the part:

• The part should be overall 4.25 long by 2.63 tall 
 by 1.75 wide; 
• It will need two clearance holes for mounting bolts 
 and a precision hole in the bottom on which to locate 
 with the Ø.500 dowel on the Key;
• It will need a shelf for clearance of the Ø5.875 X .250 
 flange on the Hub as well as a corner relief on the 
 primary shelf for the Ø9.000;
• Review Figures 11-5 and 11-6, along with their 
 related text, for supplementary information.

Step 6:  Start designing. Make sure you are in Model Space and 
remember to always draw at full size. Set your Layer 
Control to one of your Object line layers. Draw a  
horizontal construction line followed by a vertical 
construction line to the left and intersecting with the 
horizontal line. See Figure 8-10.

Process Note: Construction lines allow for a quick 
representation of the part.
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Figure 11-10

Step 7:  Use the Offset command to generate the “box” shape 
of the part. Offset the horizontal line by 2.63 (up) and 
the vertical line by 4.25 (to the right). See Figure 11-11. 
Follow the same steps to create a Top View. See Figure 
11-12. Remember to keep all views aligned with each 
other.

Figure 11-11

Process Note: Refer to the following images to see how 
the finished part will look.

Step 8:  Draw the orthographic projection of the part. See Figures 
11-13a through 11-13c for the dimensions for which you 
can construct the part.

 

Figure 11-13a: Sectional view of front

Figure 11-13b

Step 9:  Once the three basic views are constructed, draw  
the bottom view. Refer to Figure 11-8b for helpful 
dimensions on detailing the bottom view. Note the 
.7500±.0005 dimension for the Key’s width and the  
slot feature in Figure 11-13c with the .7515 dimension. 
This slot feature will aid in locating the part on the  
Key. See Figure 11-13d for the dimension values that 
locate the hole for the Ø.500 dowel on the Key and the 
starting location for one of the through holes for the 
fastening hardware.
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Figure 11-13c

figure 11-13d

process note: The dimension values and their respective applied 
tolerances may not be entirely correct. Case in point, the 1.310 
value in the Front view will not accurately locate the surface for 
the Surface Datum of the Hub to rest on. A better choice would 
be to dimension from the top of the key slot to that surface and 
apply a tolerance of ±.003 to this feature. The new dimension 
would be 1.190±.003.

Step 10:  Check your four views for proper alignment. Make sure 
that all lines are transferred from one view to the next. 
Once you have done so, remember to change the layer 
values for all lines so that hidden lines are hidden lines 
and the lines that represent the center of the holes are 
center lines.

Step 11:  Continue applying the remaining drawing details to each 
view. Observe that in all Figures of 11-13 the proper use 
of hidden lines, center lines, a Full Sectional view, and 
a Broken Section view. The Top view has the Broken 
Section view to highlight the radius value of 4.69 for the 
corner relief feature. Without doing so would have left  
a hidden line feature that could not be dimensioned.  
The Full Sectional view in the Front view may not be  
necessary however it does add clarity to the features. 
Add the Cutting Plane line in the Top view and note  
the section name on the Front view.

Step 12:  Arrange the views to be about 2.38 apart initially. Once 
you start applying dimensions you may find this distance 
needs adjustment. (The Right Side view may end up 
about 3.25 away from the Front view.)

Step 13:  Apply the dimensions including the appropriate  
tolerances where needed.

process note: You should be able to show the model at 1:1 in 
Paper Space and therefore you can dimension the model with a 
Dimension Setting Comprehensive Scale Factor of 1.

Step 14:  Switch to Paper Space and arrange the drawings to  
clearly show all views. Refer to Figure 11-14 for a 
sample representation of the part layout with the  
dimensions applied. The general notes and title block 
detail have been omitted. 
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Figure 11-14: Chuck Jaw



103

fundamentals of draftting

 

Figure 11-15: Hub 
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